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Abstrakt

Préce se zabyva popisem jednotek v procesoru a zpusobem jejich propojeni ve skalarnim a
superskalarnim procesoru. Déle se zaméruje popisem problematiky prace s paméti a zejména
popisem mezi-paméti. Popisuje fungovani prekladace z vysstho programovaciho jazyka do
jazyka symbolickych instrukeci. Déale prozkouméva dostupné simulatory procesori a mezi-
paméti, zaméruje se zejména na simulator, na ktery tato priace navazuje.

Na zakladé analyzy byly navrzeny a nasledné implementovany rozsifeni soucasného si-
mulatoru o pamétovy subsystém, podporu vyssiho programovaciho jazyka a sbirani vétsiho
mnozstvi statistik. Zavér prace shrnuje kvalitu implementace a mozny prinos simulatoru
pri vyuce predmétu Architektury vypocetnich systému.

Abstract

In this thesis, I firstly focus on functional units inside processors and how they are intercon-
necetd in scalar and superscalar processor. Then, I describe the memory hieararchy with
focus on caches. Next, I describe how compilers do translation from higher level language
into assembly. Then, I have a look at available processor simulators and cache simulators
and more closely describe the simulator that this thesis is based on.

Thanks to the information from the analysis, I propose possible extensions to the simu-
lator by adding memory subsystem, compiler and gathering more statistics. In the end, I
have a look at my implementation and investigate possible benefits to the "Computation
Systems Architectures" lectures
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Kapitola 1
Uvod

vvvvv

a algoritmi v nich pouzitych je stile naro¢néjsi. Nicméné fungovani soucasnych procesoru
stale stavi na zakladech a principech vynalezenych vice nez pred dvaceti lety.

Tyto principy se snazi na Fakulté Informac¢nich Technologii VUT v Brné vysvétlit pred-
mét Architektury vypocetnich systému (AVS). V rdamci uvedeného predmétu jsou vysvét-
leny zéakladni principy fungovani procesori, které jsou casto starsi nez soucasni studenti, a
tudiz je nutné ucit zaklady nazorné a efektivné.

7 toho dtvodu vznikl simuldtor od Jana Vavry implementujici superskaldrni procesor,
ktery pro jednodussi vysvétleni jeho fungovani umoznuje krokovani programem a zobrazeni
stavu funkcénich jednotek. V mé praci budu vychézet z uvedeného simulatoru a budu se
snazit jej vylepsit, aby studenttim prinesl vétsi uzitek.

Na zacatku prace se kratce zamérim na vysvétleni slozeni a principti fungovani super-
skalarniho procesoru. Blize se zamérim na jejich praci s paméti a na fungovani mezi-paméti.
Kapitolu 3 vénuji popisu zpusobu pribéhu prekladu z vyssiho programovaciho jazyka do in-
strukei, které je procesor schopny vykonat. V kapitole 4 prozkoumam dostupné simulatory
a hlavné se v kapitole 5 pustim do analyzy simuldtoru, ktery budu rozsirovat.

Daéle prace popise navrh rozsifeni v kapitole 6, poté se jiz pustim do samotného im-
plementovani v kapitolach 7 8 a 9, kde popisu implementaci prekladace ze zjednoduseného
jazyka C, mezi-paméti a sbéru statistik.

Nakonec v kapitole 9 zhodnotim kvalitu téchto rozsifeni a jejich mozny piinos pro vyuku
procesorii.



Kapitola 2

Architektura procesoru

Procesor (CPU - Central Processing Unit), neboli centralni vypocetni jednotka, predstavuje
zakladni komponentu pocitace, kterd se stara o rizeni celého zarizeni. Novodobé procesory
vykonavaji miliardy operaci za sekundu. Tyto operace se daji rozdélit do nékolika kategorii:

e Vypocetni.
e Prace s paméti.

Rizeni béhu programu.

1

Privilegované operace.

2.1 Funkc¢ni jednotky v procesoru

Operace, které procesor vykonava, jsou rozlozeny do nékolika funkénich jednotek, v zavis-
losti na podobnosti operaci. Kazdy procesor nemusi mit vSechny tyto jednotky nebo vibec
implementovat vSechny tyto operace. Nékteré procesory mohou sloucit vice operaci do jedné
jednotky, nékteré je mohou rozdélit. Drobné detaily jiz zavisi na konkrétnim procesoru.

2.1.1 Vypocetni jednotky

Zakladni vypocetni jednotka nachazejici se v témér kazdém procesoru je Aritmeticko-logicka
jednotka (ALU), kterd se stard o vykonavani jednoduchych operaci. Mezi né patii napiiklad:
Scitani a odéitani celych ¢isel, bitové posuvy a vyrezy, logické operace, porovnavani apod.

Dale procesory obsahuji jednotku vykonavajici operaci nasobeni a déleni celych ¢isel.

Pro vypocty v plovouci fadové ¢arce vyuziva procesor FPU (Floating point unit). Tyto
jednotky casto (ale ne vzdy) implementuji standard IEEE 754[2]. Pomoci mnozstvi vyko-
nanych operaci v plovouci fadové ¢arce se Casto porovnava vykon pocitacu a hlavné super-
pocitaci. K tomu se pouziva termin FLOPS (Floating point operations per second) nebo
spise castéji TFLOPS (Tera FLOPS - biliény operaci v plovouci fadové ¢arce za sekundu),
i kdyz novodobé superpocitace jiz dosahuji fadové vyssich jednotek [15].

Nékteré novodobé procesory jsou vybaveny vektorovou jednotkou, kterd v sobé obsahuje
nékolik vipocetnich jednotek, ¢imz umozni vykonat stejnou operaci nad fadou dat. Siika
vektorovych operaci a podporované operace zavisi na architekture procesoru. Bézné vykon-
néjsi procesory s architekturou x86 implementuji napiiklad rozsifeni AVX-512[19], které

'Napiiklad operace ménici funkcionalitu instrukei, zakdzani /povoleni nékterych instrukef apod.



pracuje nad daty o Sifce az 512 bitt. Pokud tedy takovy procesor vykona jednu vektorovou
instrukeci nad 16-bitovymi daty, provede 32 (512/16) operaci. Coz je jesté zjednoduseno,
protoZe instrukce muze vykonavat spojené operace a tedy jich udélat jesté vice (napf. VF-
MADD - Vynéasobi a secte).

2.1.2 Jednotky pro praci s paméti

Hlavni jednotka pro préci s paméti je LSU (Load/Store unit), kterd fesi vypocet cilové
adresy, ukladani a nacitani dat z paméti, povoleni nebo zakazani téchto pristupu a vysled-
nou komunikaci s paméti. Uvedend jednotka se sklada z nékolika vestavénych jednotek.
Konkrétné se jedna o:

o Nacitaci a ukladaci vyrovnavaci paméti. Ty se staraji o ulozeni probihajicich operaci,
nez se uvolni misto na sbérnici.

o MAU (Memory-access unit) se stard o komunikaci s paméti.

¢ Jednotky pro kontrolu prav pristupu. Téchto jednotek mize byt vice, v zdvislosti na
pouzitych systémech kontroly (napf. virtualni pamét).

Navic procesory bézné obsahuji mezi-paméti, které budou blize popsany v kapitole 2.4.2

2.1.3 Jednotka pro rizeni béhu programu

Rizeni béhu programu spoéiva ve skocich a vétvicich instrukeich. Vétveni predstavuje jednu
z nejzakladnéjsich instrukei procesoru, protoze se pouzivaji naptiklad k implementaci if-
then-else piikazi a cykli. O vyhodnocovani, zda se ma vétveni a nasledny skok provést a
vypocet cilové adresy, se stard BRU (Branch unit)

2.1.4 Jednotka pro praci s privilegovanymi instrukcemi

Procesory casto obsahuji vice privilegovanych médu, které umoznuji ménit funkcionalitu
v zévislosti na aktudlnim moédu (napf. operacni systém umoznuje programim provadét
operace pouze nad urcitym tsekem v paméti, ¢imz zvysuji ochranu pocitace proti skod-
livym programum). Privilegované instrukce méni zpusob, jakym procesor provadi nékteré
instrukce. Muze se jednat o zakdzani nékterych instrukci, zménu povolenych adres pri pri-
stupu do paméti, zménu aktualniho privilegovaného médu apod.

2.1.5 Dalsi jednotky

Vsechny zatim popsané jednotky primo vykon&dvaly instrukce. Nicméné procesor pro své
fungovani potirebuje i dalsi jednotky.

Nacitani instrukcei

Jednu z takovychto zdkladnich jednotek predstavuje FU (Fetch-Unit). Tato jednotka se
stard o nacteni dalsich instrukeci z paméti. U super-skalarnich procesortu nacita instrukce
dfive, nez je muze vykonat, aby tyto instrukce byly dostupné co nejdrive. V pripadé pro-
gramu, ktery neprovadi skoky nebo vétveni byva tato funkcionalita velmi jednoduchd, pro-
toze se nacitaji dalsi instrukce v programovém poradi.



Kazdy program ale obsahuje vétveni a to komplikuje toto pred-nacitini. Aby byla FU
schopna zdsobovat instrukcemi zbytek procesoru vyuzivi BP (Branch Predictor - predik-
tor skokt). Prediktor skokii se snazi odhadnout, zda nactend instrukce predstavuje skok
nebo vétveni, zda se toto vétveni pouzije a cilovou adresu. V piipadé spravného urcovani
vysledku muze razantné snizit penalizaci skoku. Predikce skoku lze implementovat rizné.
Nejjednodussi prediktory ocekavaji, ze se skok vzdy provede, coz naptiklad mize zvednout
vysledky nékolika poslednich vétveni, bud maji ulozeny vysledek daného vétveni, nebo mo-
hou pomoci nich vysledek odhadnout. Jednotka obsahuje seznamy poslednich skokii, jejich
cilové adresy (ta je vétSinou neménnd) a Fizeni predikce skoku (implementujici konkrétni
algoritmus predikce).

FU stejné jako LSU obsahuje jednotku pfimo vykonavajici pristup do pameéti, ke které
je Casto pripojena mezi-pamét. Navic si jednotka uklada pred-nactené instrukce.

Ukladani stavu programu

Procesor sém o sobé pro své potieby vyuziva registry (malé pamétové bloky) uklddajici
stav procesoru, nicméné z pohledu vykonavani programu musi i obsahovat registrové pole,
kde si program uklada data, nad kterymi pracuje.

2.1.6 Propojeni jednotek ve skalarnim procesoru

Jednu z optimalizaci, kterou procesory vyuzivaji, pfedstavuje zretézovani operaci. Vykona-
vani instrukce probiha v nékolika fazich: Nacteni — dekdédovani — vykonani — pristup do
paméti — ulozeni vysledku. Uvedené faze se bézné rozdéluji do jednotlivych trovni pro-
cesoru. Jednotlivé tirovné mohou byt spojené nebo rozdélené na vice ¢asti v zavislosti na
navrhu procesoru a jeho slozitosti. Nicméné (témér) vSechny instrukce projdou vSemi témito
fazemi a tudiz se daji instrukce vykonavat zfetézené (jako na obrézku 2.1). Takovy proce-
sor vykonava nékolik instrukei zaroven. I diky této optimalizaci mohou novodobé procesory
dosahovat rychlosti miliard taktt za vtefinu.

Fe Id Ex Mem Wb
Fe Id Ex Ex Wb
Fe Id Id Ex Wb
Fe Fe Id Ex Wb

Obrazek 2.1: Instrukce prochéazejici vSemi ¢astmi vypoctu. Instrukce nepracujici s paméti
¢ekaji na uvolnéni zépisu vysledku a jsou zdrzeny o jeden cyklus (vyobrazeno cervené).

Nicméné skaldrni procesor vykonava vSechny instrukce v poradi v jakém jsou uvedeny
v programu a tudiz nevyuziva plné vsechny své jednotky, protoze déletrvajici instrukce za-
stavuji vykonavani nasledujicich kratsich instrukei. Procesor musi navic zastavit vykondvani
nasledujicich instrukci, pokud mezi nimi nastavda RAW hazard - vice o hazardech v kapitole
2.2.1).



2.2 Superskalarni procesor

Béhem vykonavani programu skalarni procesor v jeden okamzik nevyuziva vétSinu svych
vypocetnich jednotek, proto pro zvyseni efektivity zacaly vznikat superskalarni procesory,
které jsou schopné spustit vykonavani instrukci na vice funkcénich jednotkach zaroven a
umoznuji dokonceni vice néz jedné instrukce za jeden takt hodin. Superskalarni procesory
Casto obsahuji vice funkénich jednotek jednoho druhu.

Superskalarni procesor musi zajistit dostateé¢ny prisun instrukci, aby zvladl plnit funkéni
jednotky takovym zpiisobem, ze v idedlnim ptipadé jsou vyuzity vSechny funkéni jednotky.
Coz neni vzdy mozné. Instrukce, které procesor vykonava, maji mezi sebou Casto zavislosti.
Prekladace programu se snazi davat instrukce za sebe takovym zpiisobem, aby limitovaly
tyto hazardy. Nicméné uzitecny program neni mozné udélat bez zavislosti. Prekladace musi
prekladat programy, aby je vice druhu procesoriu bylo schopno vykonavat efektivné. Z uve-
deného duvodu program nebyva prelozen optimalné na cilovou architekturu. Superskalarni
procesory tedy vykonavaji instrukce mimo poradi v jakém jsou uvedeny v programu, coz
miliZze pomoci vyresit zavislosti mezi instrukcemi. Instrukce nezavisejici na vysledku aktu-
alné vykonavanych instrukci mohou predbéhnout instrukce, které na nich zavislé jsou.

2.2.1 Datové hazardy

Hazard v procesoru nastava, kdyz se v programu za sebou nachaz{ instrukce pfistupujici ke
stejnym registrim nebo mistim v paméti. Existuje nékolik druha hazardu:

e WAW - dvé instrukce po sobé zapisuji do stejného registru.

e RAW - prvni instrukce zapisuje do registru, ktery dalsi instrukce cte.

e WAR - prvni instrukce ¢te z registru, do kterého nasledujici instrukce zapisuje.
e RAR - dvé instrukce po sobé ¢tou ze stejného registru.

Jelikoz skaldrni procesor vykonava instrukce v poradi, v jakém jsou v programu, a
vzdy dokonéi maximalné jednu instrukci, tak pro néj RAR, WAR a WAW hazardy nejsou
problematické. Bud prvni instrukce neméni stav procesoru (RAR, WAR) nebo nasledujici
instrukece tuto zménu stejné prepise (WAW). V pripadé RAW hazard musi skaldrni procesor
pozastavit vykonavani vSech nasledujicich instrukci, nez se zapisujici instrukce dokondi.
Uvedend situace muze nastat napriklad, kdyz jedna instrukce vykonava déleni, které muze
trvat desitky cykli, a nasledujici instrukce s témito daty pracuje.

Oproti tomu superskaldrni procesor plni funkéni jednotky dalsimi instrukcemi [5], které
nejsou konfliktni, a mize je vykonat diive. Superskalarni procesory umoznuji i vykonavani
instrukci mimo poradi. Kvuli témto optimalizacim musi superskalarni procesor resit i ty
hazardy, které nezpusobuji problém ve skalarnim procesoru.

Pro tyto dcely se vyuziva mnoho algoritmt. V ramci predmétu AVS se uci dva zakladni
algoritmy scoreboarding a Tomasuluv algoritmus. Scoreboarding[16] predstavuje jednodusi
algoritmus, udrzuje si informaci o vykonavanych instrukcich, jejich operandech a jejich
platnosti. Tento algoritmus fesi vSechny typy hazardu, nicméné stale WAW a WAR hazardy
fesi zastavenim vykonavani dalsich instrukci. Oproti tomu Tomasuluv algoritmus se umi
vyporadat i s témito hazardy. Navic je implementovan v simuldtoru, na ktery tato prace
navazuje, a proto bude popsan blize.
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2.2.2 Tomasulo algoritmus

Tomasulo algoritmus, navrzen Robertem Tomasulo v 60. letech, byl poprvé pouzit v proce-
sorech IBM. Prestoze byl tento algoritmus vymyslen pred vice nez 50 lety, je stale aktualni
a principy v ném pouzité se stile vyuzivaji.

Prejmenovani registra

Uvedeny algoritmus resi hazardy, které mohou v procesoru nastat, prejmenovavanim pou-
zitych registru (Register Renaming) z architekturdlnich oznaceni na mikro-architekturalni
oznaceni. Implementace téchto registrii muze byt implementovana bud v serazovaci paméti
(Reorder buffer - ROB), nazyvaném také implicitni pfejmenovavani [16][17], kde vykonané
instrukce maji ulozeny vysledek v této paméti a pamatuji si jaka instrukce je vykonala.
Nebo procesor obsahuje oddélené registrové pole pro prejmenované registry, pripadné obsa-
huje vétsi registrové pole nez architektura specifikuje. Ziskané vysledky jsou tedy ulozeny
primo do prejmenovaného registru, coz se nazyva explicitni prejmenovani[16][17]. V obou
pripadech vyvstava potreba pamatovat si mapovani prejmenovanych registrii na registry
architekturalni, k ¢emuz se vyuzivi RAT (Register Alias Table)

Rezervaéni stanice

Rezervacni stanice se staraji o vypousténi instrukei do funkcénich jednotek. Pro tento 1ucel
si rezervacni stanice udrzuji instrukce, jejich vstupni operandy, platnost a ukazatel do sera-
zovaci paméti.[16][5] Pokud se architekturdlni registr namapuje na spekulativni, je platnost
tohoto registru nastavena na 0. Pokud jsou data dostupnd, platnost se nastavi na 1 a in-
strukce si ulozi hodnotu vstupniho operandu. Pokud ma instrukce vSechna vstupni data
platna a volnou funkéni jednotku, spusti se vykonani instrukce. Rezervacni stanice se snazi
uprednostnovat nejstarsi instrukce a ty které blokuji nejvice dalsich instrukei.

Komunikaéni sbérnice

Vsechny rezervacni stanice v procesoru jsou pripojeny na sdilenou sbérnici, kam pfi dokon-
¢eni instrukce posilaji funkéni jednotky jejich vysledek. Rezervacni stanice si tudiz mohou
ulozit vysledek do svych ¢ekajicich instrukci bez nutnosti ¢teni z registru.

Serazovaci pamét

Serazovaci pamét se pouziva k ulozeni instrukci, nez je mozné je dokoncit. Uklada si do-
koncené instrukce a v zavislosti na implementaci i vysledky jejich operaci. U instrukei se
uklada zda se vykondvaji, zda jsou spekulativni (vykonané na zakladé predikce skoki), zda
je instrukce validni a mapovani na prelozené registry. Kdyz je instrukce validni, nevyko-
nava se a neni spekulativni, je mozné ji dokoncit a zapsat jeji vysledek do architekturalniho
registru.[16]

2.3 Dalsi optimalizace vykonu procesoru

Vzhledem k pridané logice jsou ale procesory vykonavajici instrukce mimo programové
poradi méné pouzivané, nez by se mohlo na prvni pohled zdat. Tato technika optimalizace
vykonu se viibec nepouziva ve vestavénych zarizenich, ktera nepotrebuji takovy vykon, misto
toho casto cili na nizsi spotiebu a plochu. Uvedené Casto plati i o mobilnich telefonech, kde
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| Typ paméti | Rychlost piistupu ‘ Velikost

Pevny disk miliény cykla v TB
Operacni pamét stovky cykli v GB
Mezi-pamét jednotky az desitky cykla v KB az MB
Registry v procesoru 1 cyklus vétsinou v Bytech

Tabulka 2.1: Rychlost a velikost paméti

se stale hojné vyuzivaji procesory vykonavajici instrukce v programovém poradi. Napriklad
podle nabidky firmy ARM, pfedniho vyrobce procesorii do mobilnich telefonu a vestavénych
systémi, pouze jejich nejvykonnéjsi procesory vykondvaji instrukce mimo-poradi [4].

Nicméneé se vyuzivaji i jiné optimalizacni techniky. Hlavni takovou technikou jsou vice-
jadrové procesory. Tyto procesory spojuji vice samostatnych jednotek schopnych vykonavat
programy (véetné nac¢itdni programu, dat a udrzovani stavu programu) nezavisle na ostat-
nich jadrech.

Podobn4 technika je multi-threading, kde vice programi (vétsinou 2) sdili jedny zdroje.
Tento program se nazyva vldkno a v pripadé, ze jedno z vldken nemuze vykonavat své in-
strukce kvili hazardiim nebo protoze ¢eka na vysledek z paméti, prepne se vykonavani na
druhé vlakno, ¢imz se udrzuje vétsi vytizeni procesoru. Vykon wvice-vldknovgch procesoru
hodné zavisi na rychlosti prepindni vlaken (nékolik cyklu, jeden cyklus, vldkna se mohou
vykonavat zarover), ale hlavné zavisi na podpore opera¢nim systémem, ktery na tyto pro-
cesory musi davat aplikace, jez zvladnou vyuzit zdroje efektivneé.

2.4 Paméti

Data v pocitacovém systému se uklddaji na trvalé dlozisté (napt. SSD nebo pevny disk),
nicméné trvalé tlozisté je moc pomalé, aby procesor mohl pracovat pfimo nad nim a proto
se programy pred spusténim nahraji do opera¢ni paméti, kde se vykonavaji. Operacni pamét
je rychlejsi nez trvalé lozisté, ale také o dost mensi. Ale i opera¢ni pamétf pracuje prilis
pomalu, protoze pristup do operac¢ni paméti trva stovky procesorovych cykli. Z toho divodu
vznikly mezi-paméti [18], které jsou jesté rychlejsi, ale o to mensi. Casto tak malé, Ze se do
nich nevejde cely program.

Duvodem pro zvétsujici se rychlost mezi-paméti je jednak technologie ulozeni dat, ale
hlavné vzdalenost paméti od procesoru. Duvod, pro¢ se nepouziva stejna technologie na
opera¢ni paméf i na mezi-paméti, predstavuje prilis vysoka cena tohoto feseni. Uvedeny
pristup se jevi navic zbytecnym protoze by prinesl minimalni navysSeni vykonu.

2.4.1 Casova a prostorova lokalita

Jak jsem se jiz zminil, mezi-paméti jsou c¢asto mensi nez programy a data, ke kterym
pristupuji. Nicméné to nevadi z diivodu ¢asové a prostorové lokality v programech, ¢ehoz
mezi-paméti vyuzivaji. Programy jsou vykonavany sekvencéné a jednotlivé kusy kédu byvaji
tedy casto blizko sebe. Navic se v kodu ¢asto objevuji cykly, tudiz je pravdépodobné, ze
jednou zpracovany kéd se bude vykondvat znovu. To samé plati o zpracovavanych datech.
Program casto pristupuje ke stejnym proménnym v urcité ¢asti programu a k dattim blizko
sebe (napt. pole). Jako piiklad by bylo mozné uvést tento jednoduchy cyklus:
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for(i = 0; i<array.size(); i++) {
sum += array[i]

}

Tento cyklus provadi stéle stejné instrukce a pouze se postupné posouva dale v poli a pricita
jeho data do jedné proménné. Mezi-pamét miuze uvedeny cyklus vyrazné zrychlit.

2.4.2 Mezi-paméti

Mezi-pamét je umisténa na vystupu procesoru v nékolika drovnich [13]. V zéavislosti na slo-
Zitosti procesoru a pozadovaném vykonu se pridava dalsi uroven, ale maximéalné se pouzivaji
ti1 drovné 2.

Prvni troven mezi-paméti (L1 cache) byva umisténa piimo v procesoru a nabizi nejrych-
lejsi pristup k dattim, tudiz musi byt mala. Tato mezi-pamét byva rozdélena na instrukéni
a datovou, protoze dva zdroje pristupu do paméti pracuji nad rozdilnou ¢asti pameéti.

Druhé troven mezi-paméti (L2 cache) byva umisténa na stejném ¢ipu jako procesor.
Nenabizi jiz tak rychly piistup, ale oproti tomu o dost vétsi prostor pro data. Druhd droven
se zaméruje, aby pokud mozno jiz obsahovala data, ke kterym se pristupuje.

Tret{ troven mezi-paméti (L-3 cache) nejéastéji vyuzivaji vice-jadrové systémy, kde je
tato mezi-pamét sdilend mezi vSemi jadry, coz zrychluje pristup, pokud vice-jader pracuje
nad stejnymi daty a zaroven zajistuje koherenci dat mezi témito jadry.

2.4.3 Fungovani mezi-paméti

V této ¢asti bude vysvétlena funkcionalita datové mezi-paméti. Stejné principy se vyuzivaji
i na instrukéni mezi-paméti s tim rozdilem, ze do instrukéni paméti nelze zapisovat.

Zakladni prvky

Mezi-paméti si udrzuji posledni pouzivand data. Data jsou rozdélend do bloku (nebo také
angl. cache-line), kde jeden blok je nejmensi adresovatelny prvek touto mezi-paméti. Ty-
picky byva velikost jednoho bloku mezi-paméti mezi 16B a 64B[18]. Procesor mize pristu-
povat k mensim datim nez je blok, ale mezi-pamét pracuje s daty po celém bloku. Aby
mezi-pamét védéla, kterd data jsou platnd, obsahuje Valid bit. Tento bit se pfi spusténi
nastavuje na 0 a na hodnotu 1 se nastavi az po nacteni dat. Pokud procesor pozaduje data,
kterd jsou jiz v mezi-paméti nactend (maji Valid bit nastaveny na hodnotu 1), posle je
procesoru a s paméti neni potieba komunikovat. Takovy pripad se oznacuje jako cache hit.
Pokud mezi-pamét data neobsahuje, nacte je z paméti (nebo z nésledujici mezi-paméti),
¢emuz se Tika cache miss. V pripadé, ze procesor data do mezi-paméti zapise, u dané bloku
se nastavi Dirty bit na hodnotu 1. Znac¢i tim, ze dana data byla zménéna, a blok neobsa-
huje stejnou hodnotu jako v paméti. Dale si mezi-pamét uklada adresu danych dat. K tomu
vyuziva Tag a Index, které jsou ziskané z adresy.

2Né&které procesory obsahuji i éty¥i irovné mezi-paméti pro zrychleni grafickych aplikaci. Nicméné vétsina

vvvvvv

na férech je oznacovali za nestandardni.
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Pri pristupu do mezi-paméti se adresa rozdéli na tfi ¢asti - Tag, Index a Offset, kde:
o Indez je adresa bloku v mezi-paméti.

e Offset adresuje data uvniti bloku.

e Tag slouzi k rozliseni adres, které se namapuji na stejny index.

Jejich velikost zavisi na velikosti mezi-paméti. Obrazek 2.2 vyobrazuje zptisob déleni adresy.

Adresa pfistupu Tag Index | Offset

Ox6¢ :> 0000000000000000000000000 | 110 1100

Obrazek 2.2: Rozdéleni adresy na Tag, Index, Offset

Asociativita

Mezi-paméti se daji rozdélit do tii kategorii podle zptusobu adresovani dat uvniti mezi-
paméti, tedy podle asociativity[13]:

e Primo mapovana.
e Plné asociativni.
o N-cestné asociativita.

V primo mapované mezi-paméti ma kazda adresa své konkrétni misto, kam miize
byt namapovana. Podle dekédovaného Indexu se namapuje adresa na konkrétni blok mezi-
paméti. Neni mozné pouzit jiny blok, i kdyby byl volny.

Oproti tomu stoji plné asociativni mezi-pamét, kde se kazda adresa miize namapovat
na jakykoliv blok. V této implementaci ma Indez velikost nula (nepouziva se). Oproti primo
implementaci, protoze mezi-pamét musi porovnavat Tag z pristupované adresy s Tagem
kazdého bloku v mezi-paméti, coz zvysSuje slozitost implementace.

Mezi nimi samoziejmé existuje i kompromis v podobé N-cestné mezi-paméti, kde N
znaci, kolik adres se miize namapovat na jeden Index. V tomto piipadé se nejprve namapuje
Index z adresy na Index v mezi-paméti a poté vybér funguje stejné jako u plné asociativni.

Politiky vymény

Pokud pristupovana adresa v paméti neni a namapované misto je volné, mezi-pamét data
nacte. Problém nastava v situaci, kdy namapované misto volné neni. V pripadé primo
mapované mezi-paméti je postup jednoduchy: Pokud dany blok obsahuje prepsana data
(mé nastaveny Dirty bit na hodnotu 1), nejdiive se ulozi do paméti, a poté se nacte blok
novy. Pokud obsahuje data nepozménénd, rovnou se prepise.

Protoze v pripadé plné asociativni nebo N-cestné mezi-paméti, vice adres sdili jeden
Index, musi nejprve vybrat blok, ktery bude nahrazen. Existuji ruzné politiky vymény [3]
obéti (wvictim), neboli bloku, ktery se ma nahradit. Zde zminim pér jednoduchych z nich,
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Nahodnéa obét
Nejjednodussi politika, kterda vybere nahodné svoji obét.

Politika FIFO

Politika FIFO vybira jako obétf blok, ktery je v mezi-pameéti nejdéle. Tato politika je velmi
jednoducha na implementaci, nicméné nebere v potaz, jakym zpusobem kod s daty pracuje,
a tedy muze vymeénit ¢asto pouzivany blok.

Politika LRU

Relativné ¢asto pouzivana a jednoduchd politika, ktera si udrzuje informaci o poradi po-
slednich pristupt k jednotlivym blokim. Kdyz musi vybrat obét, vybere nejdéle nepouzity
blok (Least Recently Used). Uvedend politika vylepsuje FIFO o ochranu posledné pouziva-
nych bloku, ale ma velky problém, pokud program pracuje s daty vétsimi nez mezi-pamét,
protoze kazdy pristup zpusobi vypadek. Tomuto chovani se v angli¢tiné ¥ika Trashing [3].

Politika LFU

Politika vybird jako obét nejméné casto pouzivany blok (Least Frequently Used). Pristup
udrzuje ¢asto pouzivané bloky ulozené. Nevyhodu predstavuje, Ze se Spatné vyporada s to-
kem programu, kde dfive ¢asto pouzivané kusy paméti jiz program nepotiebuje pouzivat.
Takové bloky ziistanou ulozeny a blokuji misto dalsim. Proto se spiSe vyuzivaji verze tohoto
algoritmu, které tento problém fesi [3].

Pristupy do paméti

Dalsi nastaveni, jez mezi-paméti mohou mit, ovliviiuji jejich pristup k zapisum dat. Pokud
jiz mezi-pamét obsahuje dany blok, muze se zachovat dvéma zpusoby:

o Data se ihned propisi do paméti ( Write-through).
o Data se propisi do paméti az pfi vyméneé této cesty ( Write-back).

Pokud se data propisi do paméti ihned, nemusi si mezi-pamét udrzovat informaci, zda data
nejsou zménéna (Dirty bit).
Pokud mezi-pamét dany blok neobsahuje, opét se muze zachovat dvéma zpusoby:

o Mezi-pamét pocké, nez se dany blok nacte, a pak data ulozi( Write-allocate).

e Mezi-pamét rovnou zapise do paméti.

L2 mezi-paméti

Mezi paméti na druhé trovni (a pfipadné dalSich) jiz nemayji tak tvrdé néroky na rychlost
odpovédi, coz umoznuje vétsi velikost. Nicméné pii pouziti vice trovni je potfeba urcit, jak
bude kazda dalsi troven pracovat s daty na nizsich trovnich. Konkrétné existuji dvé hlavni
moznosti [20]:

e Inkluzivni: Obsahuje vSechna data jako nizsi trovné.

o Exkluzivni: Obsahuje jen data, co se nenachézi na nizsi drovni.
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Exkluzivni mezi-pamét se na prvni pohled muze jevit jako lepsi volba. Protoze si dalsi
drovné nepamatuji stejnd data jako na nizSich drovnich, celd kapacita se vyuzije na dalsi
data. OvSem uvedené s sebou pfindsi mnohem slozitéjsi implementaci pii vice-jadrovych
logice mé rovnéz delsi dobu odpovédi[20]. Diky vétsi velikosti ma vétsi dspésnost.

Obé z téchto variant vyuzivaji navic malou mezi-pamét (victim cache, nebo victim buf-
fer) na obéti prvni mezi-paméti.

Je tézké urcit lepsi z téchto pristupt. Kazdy ma své vyhody a stale se vyuzivaji.

2.4.4 Zavér

Cilem kapitoly bylo vysvétleni fungovani procesoru a poukazani na jeho slozitost. Clovek,
ktery pocitac¢tim rozumi, muze pochopit fungovani procesort bez nazornych ukazek. Mnoha
studenttim ale muze délat problémy si danou problematiku predstavit, a proto je vhodné
nazorné vysvétleni. Coz byl duvod vzniku simuldtoru Jana Vavry i této navazujici prace.
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Kapitola 3

Prekladace

V kapitole bude popsano fungovani prekladac¢ia. Vychazet budu prevazné z knihy FElements
of Compiler Design [9].

Psani kédu primo v jazyce symbolickych instrukei predstavuje velmi naroény a zdlou-
havy proces. Pro jeden typ procesoru bychom teoreticky byli schopni napsat nejoptiméalnéjsi
kéd, ktery by vyuzival plné cilenou architekturu. Takovy vyvoj by ale byl prili§ nakladny,
proto se v podstaté nikdy nevyplati. Nejenom zZe by vyvoj byl pomaly, navic bychom byli
zavisli na pouzivani stejného typu procesoru.

7 toho duvodu se vyuzivaji prekladace, které obecné prelozi kéd z jednoho jazyka do
druhého, a pritom zachovaji jeho funkcionalitu. Vétsinou se prekladace vyuzivaji na ptelo-
Zeni programu napsaném ve vyssim programovacim jazyce (C, C++, Pascal atd.) na cilovou
architekturu. Diky tomu muzeme stejny kod vyuzit na vice architekturach a neni nutné znat
tyto architektury tak dikladné. Kéd napsany ve vysSsim programovacim jazyce je mnohem
Citelnéjsi a rychlejsi na vyvoj. Jeden preklada¢ mize podporovat vice zdrojovych jazyk,
protoze nékteré ¢asti prekladu lze pouzit znovu.

3.1 Faze prekladu

Béhem prekladu kédu zpracovavaji prekladace program v nékolika fazich: [9]
¢ Lexikalni analyza.
e Syntakticka analyza.
e Sémanticka analyza.
e Generovani vnitiniho kédu.
e Optimalizace vnitrniho kédu.
e Generovani cilového kdédu.

Lexikalni analyza zpracovava program a rozdéluje jej do jednotlivych lezémai (slov).
Zpracovani provadi prochazenim znak po znaku a podle dané sekvence znaki oddéluje jed-
notlivé lexémy. Z téchto lexéma vytvari tokeny, které jednotné reprezentuji lexémy. V pri-
padé potieby pridava k lexémim dalsi charakterizujici atributy. Vzniklé tokeny nasledné
posila do syntaktické analyzy.

Syntaktickd analyza zkoumé strukturu tokenu a vyhodnocuje, zda spliuji syntax
konkrétniho jazyka. Syntax jazyka je dana gramatickymi pravidly, ze kterych se vytvori
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syntakticky analyzdtor. Ten transformuje dany program pomoci téchto pravidel k utvoreni
syntaktického stromu. V pripadé, ze se syntakticky strom nepodari sestavit, preklad selze,
protoze vstupni program neni validni. Kdyz se strom podari sestavit, je program syntakticky
spravne.

Sémanticka analyza zkoumad, zda program splnuje sémantiku daného jazyka. Kon-
krétné se jedna prevazné o typovou kontrolu. Chyby v této ¢asti mohou zpusobit selhani
prekladu nebo pouze varovani, kdy se prekladac¢ s touto chybou vyporada automatickou
konverzi.

Generovani vnitfniho kédu prevadi syntakticky strom do vnitiniho kédu reprezen-
tujici stejnou funkcionalitu jako vstupni kéd, ale vétsinou v podobé 77 adresného kédu. Ten
znazornuje kazdy prikaz vstupniho kédu v podobé kratké sekvence jednoduchych instrukei.
Tri-adresny kod nezavisi na cilové architekture.

Optimalizace vnitfniho kédu zpracovava vygenerovany vnitini kéd a snazi se in-
strukce poskladat, aby maximalizovala vykon. Tato fize je casto aplikovana opakované,
jelikoz nékteré optimalizace mohou vytvorit prostor pro optimalizace nové. Mohou byt
vseobecné nebo cilené na konkrétni architekturu. Napiiklad preskladani operaci, aby bylo
mozné vyuzit specidlni instrukce dané architektury, nebo plné vyuziti jejich registru.

Generovani cilového kédu prevadi optimalizovany kéd na cilovou architekturu. Z toho
duvodu musi byt cilova architektura prekladaci zndma. V této ¢asti vyuziva informace o po-
¢tu registri, dostupnych instrukcich apod.

3.2 Syntaxi rizeny preklad

Béhem prekladani programu nemusi byt uvedené faze vykondvany postupné, ale casto se
prekryvaji z divodu rychlejsiho prekladu. Syntakticka struktura obsahuje nejvice informaci
pro preklad, proto je hlavnim prvkem piekladu a ¥idi jej. V prubéhu zpracovavani programu
si syntaktickd analyza zada od lexikdlni analyzy dalsi tokeny. Ty po zpracovani preda
sémantické analyze, ktera je zpracuje a prida pripadné doplnujici charakteristiky. Vysledny
strom zpracuje generdatoru vnitfniho kédu a dale jiz kéd putuje ve fazich, jak bylo vyse
popsano. Celou strukturu je mozné si prohlédnout na obrazku 3.1.
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Zdrojovy program

Lexikalni analyzator

Posli token
| Zkontroluj sémantiku

Syntakticky

. Semanticke informace
analyzator

4
-

I
Vygeneruj instrukci

Generovani
vnitiniho kddu

-
" |Semanticky

analyzator

e N

Vnitini kod

i

Optimizator

I

Optimalizovany vnitni kod

Generovani
cilového kadu

Cilovy program

Obrézek 3.1: Syntaxi fizeny preklad [9]
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Kapitola 4

Simulatory

Pro efektivni uceni a vysvétleni principti procesorovych architektur se jevi uziteéné uka-
zat principy jejich fungovani na konkrétnich piikladech s interaktivnim pristupem. K tomu
slouzi simuldtory, coz jsou programy, které se chovaji jako cilovy procesor. Vizualni simu-
latory naptiklad ukazuji sviij stav a umoznuji krokovani. V této kapitole se podivim na
volné dostupné simulédtory, a poté v kapitole 5 prozkoumam simulator, na ktery tato prace
navazuje.

4.1 Simulatory procesori

4.1.1 RIPES

RIPES [11] je graficky simuldtor a editor kédu jazyka symbolickych instrukei architektury
RISC-V, ktery umoznuje i psani kédu v jazyce C, pokud simuldtor detekuje prekladac
z jazyka C do RISC-V, pripadné muzeme cestu k prekladaci zadat.

Zobrazeni v hlavnim okné

Simuldtor v hlavnim okné (na obrazku 4.1) umoziiuje simulaci krok po kroku, s nastavenim
doby trvani jednoho kroku v milisekundach. V levé ¢asti okna je prepinani mezi zobrazenim
pohledu na Procesor/Editor/Pamét /Mezi-pamét /Vstup-vystup.

Uprostied okna lze vidét architekturu procesoru s jednotlivymi funkénimi jednotkami a
propojenimi mezi nimi, rozlozené az na multiplexory, které ukazuji, jaky vstup do jednotky
se prave vybira, coz ukazuje zeleny bod na vstupu multiplexoru. Na propojeni mezi jednot-
kami je mozné kliknout, coz dané propojeni zvyrazni a zjednodusi prehlednost propojeni
jednotek. RIPES simuluje celé propojeni procesoru, a tudiz lze v kazdém bodé programu
zjistit, jakou hodnotu obsahuje port jednotky najetim na néj mysi.

V pravé Casti okna se v horni ¢asti nachézi obsah registrti, v dolni ¢asti okna je instrukéni
pamét. Toto okno zobrazuje adresu instrukce a jeji zapis v jazyce symbolickych instrukei.
Navic umoznuje nastaveni instrukce, na které se simulator zastavi pred jejim vykondnim
(breakpoint). Pokud se simulace prehrava krok po kroku, zobrazuje v jaké fazi vykonavani
se jaka instrukce nachazi. Tato data ukladd a pripadné umoznuje jejich zpétné zobrazeni.
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File Help

B O <D woms 2D B

.| Registers | 1

4 D Name Alias Value

x7 2 0x00800000

x8 s0 0x00000000
= Instr.
=1 memory N IE: o x9 s1 x00030000
- o ]
Memory L s | —1 I T
|‘ . IFID i DEX x10 a0 axeaeaeeel

= D : x11 a1 0x00000000
- I 9 x12 az 0x00800080 b’

| |
; \mm. . Display type: Hex -
. - —
Output | 4 | Statistics| 3 | Instruction memory | 2 |
= Cycles: 6 BP PC stage Instruction
Inztre. ratirad: 2 0xc  MEM lwx11-4(x11)
CPI: 3 0x10 EX auipcx12 ...
PC: 0333 0x14 |ID lwx12 -8(x12)
0x18 |IF auipcx13 ...
0x1c lw x13-12(x13)
= 0x20 ial x1 0xR4 -

Obrazek 4.1: Hlavni okno simulatoru RIPES

RIPES umoznuje vypisovani hodnot na vystup programu pomoci instrukce ecall, ktera
zavola funkci, jez vypiSse data na vystupni okno. Nakonec RIPES obsahuje nékolik statis-
tickych informaci:

e Pocet vykonanych instrukei.
¢ Kolik cykld program trval.
o Pocet cykli na vykonani jedné instrukce (CPI).

o Pocet instrukei na jeden cyklus (IPC).

Obsazené architektury

RIPES umoznuje vybér nékolika rtzné slozitych RISC-V procesorti, které vykonavaji in-
strukce v programovém poradi. Nejjednodussi procesor vykonava vse v jednom cyklu. Poté
obsahuje tfi procesory o péti fazich, s riiznou slozitosti pomocné logiky:

e Nedetekujici hazardy.
e Bez predavani vysledkti, kdyz nastane hazard.
e S predavanim vysledkt, kdyz hazard nastane.

Nejslozitéjsi procesor je Sesti-fazovy a umoznuje vykonani dvou instrukei v jednom cyklu.

Zobrazeni paméti

V levé Casti okna je mozné pohled prepnout na pamét. Okno paméti zobrazuje seznam sekci
v paméti a obsah konkrétnich pamétovych bunék s moznosti prepnuti se na jednotlivé sekce
v programu a nebo na adresu na které je ulozena hodnota z registru.
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File Edit View Help
g o> pim (D

L1 DataCache | L1Instr. Cache

Cache configuration:

3 S8 4321 0

Preset: ~ | [F)[X Access address [00000000000000010000004110111009
NLines: 5 . s
2 tines: s ) Repl policy: LR Index VD Tag  Block @ Block 1 Block 2 Block 3
2 Ways: 0 = wr.hit: Wite-back v o[ 7] 0] 000000093 | 0x004404T3 | 0x000760e7 | OxTe3318e3 | 0x0001 3437
1 00000093 | 000013937 | 0x00440753 | 0x00c0913 | 0x40790933
2" Blocks: 2 =) wr. miss: wiite allocate 2[T[0[ 0x00000093 | 0x40795013 | 0x02090863 | 0x00440413 | 0x00000493
3[1]0] 0x00000093 | 0x00042783 | 0x00148493 | 0x00440413 | 0x0007807
Plot configuration: Statistics: 4 00000093 | 0x7e9818¢3 | 0x00c12083 | 0x00812403 | 0x00412483
5{1/0] 0x00000093 | 0x00012903 | 0x01010113 | 0x00008067 | 0x00f00313
Numerator Hits v Size (bits): 4896 ) ) x00000093 | 0x00050713 | 0x02c37e63 | 0x00f77793 | 0x0a079063
7] ) x0000008 000000 7 | 0x00078793 | 0x00078863
Denominator | Totalaccesses ~ | Hitrate: 0.7435 | Writebacks: 0 8 %0000008 001353 [ 0x02d0206 | 0x00008067
- 3l e T i T o[ T[0[ 6x00000650 | 0x00003197 | 078018193 | 0xc3418513 | 0xc5018613
92vg. 19 cyc. : : : X00000080 | 0x40260633 | 0x00080593 | 0x5bAB20er | 0x00003517

1x0000009: 00000613
x0000008 2010 008806 901011 06112623
1x0000008 x06812423 | 0x06912223 | 0x07212023 | 0x05312e23

mTotal B Moving avg. | 0x00000081 | 0x07010413 | 0xf8a42e23 | 0x78b42c23 | 0x000137b7
X00000081 | 0x9b478513 | Oxebdfr0et | 0x00000793 | Oxfar42623
100 | 0x00000093 | 0x01050693 | 0x00d5e5b3 | OxT6AFTO6T | 0x00279693
| 0x00000094 | 0x00170713 | 0x09e7a223 | 0x010787b3 | 0x00b7a423
0 X00000080 | 0x01010113 | 0x00008067 | 0x08008067 | 0x000807b7
6 X00000080 | 0x00078793 | 0x08078C63 | 0x0013537 | 0xc3818593
N x00000080 | 0x00050513 | 0x00000317 | 0x08000067 | 000008067
40 | 0x00000030 | 0xFe010113 | 0x09812¢23 | 0x02010413 | 0xfead2623
20
0
0 47 95 142 190
Cycle | |
000000080 | 0x7e010113 | 0x00812e23 | 0x02010413 | Oxfead2623
Total: Cycle: 190 Value: 74.3455 000000092 | 0x7T010113 | 0x00812423 | 0x012120 0
Moving avg.: Cycle: 190 Value: 73.6842 00000009 393 0440793 | 0x004909
0] 0x00000092 | 0x00112623 | 0x00912223 | 0x4295313 | 0x02090063
. 00 0x00000092 | 0x00440413 | 0x00000493 | 0x00042783 | 0x00148493
FEER

Obrazek 4.2: Zobrazeni mezi-paméti v simulatoru RIPES

Zobrazeni mezi-paméti

RIPES obsahuje L1 mezi-paméti pro data i pro instrukce. Na obrazku 4.2 je okno RIPES
v pohledu na mezi-pamét. V levé ¢asti umoznuje nastaveni mezi-paméti a zobrazeni statistik
mezi-paméti. RIPES umoznuje nastavovat:

o Pocty blokt.

e Asociativita.

e Velikost blokii.

e Politiku vymeény blokii.

o Nastaveni propisovani do paméti.

Zobrazeni statistik umoznuje vykresleni grafu se statistikami v Case a vypisuje celkové
statistiky v aktudlnim cyklu vykonavani. RIPES sbira tyto statistiky pro mezi-paméti:

o Pocet pristuptu do paméti.

o Pocet tspésnych pristupi z procesoru do mezi-paméti.

e Pocet netspésnych pristupt z procesoru do mezi-paméti.
o UspéSnost vyuziti mezi-paméti.

V pravé ¢asti zobrazuje mezi-pamét jako tabulku se vSemi hodnotami, které se v ni
nachézi. S aktualn{ pristupovanou adresou rozdélenou na jednotlivé ¢asti, se kterymi mezi-
pamét pracuje, a s vyznacenou bunkou v mezi-paméti, jez je pravé pristupovana.
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Vstupné-vystupni okno

RIPES také obsahuje nékolik perifernich zafizeni s moznosti jejich pripojeni k procesoru,
ovladani pres procesor a zobrazeni ve vstupné-vystupnim okné. Tyto zarizeni si lze definovat
vlastni pomoci QtWidgets. Nicméné simulator obsahuje i par pred-pripravenych zarizend,
konkrétné:

e Pole vypinact.
e Led pole.

e Smérovy ovladac.

Shrnuti

RIPES simulator obsahuje kompletni vysvétleni fungovani jednodussiho procesorového sys-
tému, véetné mezi-paméti, prekladace a vstupné vystupnich operaci. Obsahuje velkou ¢ast
funkcionality, kterad predstavuje cilem i této prace, a navic nékteré dalsi funkcionality. RI-
PES obsahuje pouze jednoduchy procesor, ale nejspise by bylo mozné architekturu procesoru
rozsifovat nebo ménit, ale bylo by to naro¢né. Vytvoreni a simulace procesoru je vytvorena
pomoci néstroje, ktery vznikl z projektu RIPES. Néktera rozsiteni, napriklad dalsi statistiky
a vice mezi-paméti, by pravdépodobné nebylo mozné upravovat.

4.1.2 QTMips

QTMips[8] predstavuje simuldtor pro procesory s architekturou MIPS vyvinuty na CVUT
v ramci diplomové prace. Simuldtor umoznuje vybér nékolika jednoduchych MIPS proce-
se nachazi procesor rozdéleny na jednotlivé stupné. Nad kazdym stupném je nazev prave
vykonavané instrukce v dané fazi. Na levé strané se nachézi obsah registrii a v pravo kod
programu s adresami instrukci. Simuldtor zobrazuje propojené jednotky, véetné propoju-
jicich komparatoru a multiplexori, kde nékteré vystupni porty obsahuji hodnotu na nich.
Toto zobrazeni az na logické obvody je pouzité i v rdamci zobrazeni mezi-paméti, které je
na obrazku 4.3.

Simulator také obsahuje nastavitelné instrukéni a datové mezi-paméti stejnym zptisobem
jako RIPES. Opét propojené az na logické soucastky. Mezi-paméti sbiraji navic vykonové
statistiky:

o Pocet tspésnych pristupi z procesoru do mezi-paméti.

o Pocty netspésnych pristupt z procesoru do mezi-paméti.
e Pocet cyklu na kolik mezi-pamét zastavila procesor.

o UspéSnost vyuziti mezi-paméti.

e Zrychleni ziskané mezi-paméti.

4.1.3 OpendDLX

Simuldtor OpenDLX][14] implementuje jednoduchy MIPS procesor zpracovavajici instrukce
v péti fazich. OpenDLX nezobrazuje architekturu, ale misto toho obsahuje podrobné in-
formace, v jaké ¢asti vypocCtu se nachazi konkrétni instrukce v daném cyklu vykondvani
programu.
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Program Cache ]

Hit: 27

Miss: 5
Memory stall cycles: 45
Usage effectiveness: 84 375%
Speed improvement: 416%

Address

(01000 T

Tag Data

0x04001000

0x20080005 |0x20200000

0x20110001 |0x02115020

0x04001000

Ox0 2208020 |0x0140B820

v
1
1|0x04001000
1
1

0x04001000 |0x21200001 |Dx010958 24

| 1
Y e
—
-

Tag Data
0x04001001 |[0x1160FFFA |0x00000000

Obrazek 4.3: Zobrazeni mezi-paméti v simulatoru QTMips

Dale OpenDLX obsahuje okno se statistikami vykonavani programu:
e Pocet nactenych instrukei.
¢ Pocet dokoncenych instrukei.
o Uspésnost predikee skoku.
e Pocet skokii.
e Pocet pristuptu do paméti.
o Pocet cyklu.

Tento simulator nezobrazuje vizualné ¢innost jednotek, jako nékteré ostatni simulatory,
ale vypisuje vykonané operace do okna log. Vypisy obsahuji informace, Ze jednotka do-
koncila vypocet, provadéla danou operaci a jeji vysledek, ale i napriklad, Zze dané jednotka
neprovadéla zadnou operaci.

Simulator také obsahuje okno k napsani kédu v jazyce symbolickych instrukei architek-
tury MIPS
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Obrazek 4.4: Hlavni okno simulatoru opendlx

4.1.4 Jupiter

Jupiter[6] je otevieny RISC-V simulator, ktery implementuje zékladni 32-bitovou instrukéni
sadu (RV32I) a rozsiteni: Nasobeni (M) a operace v plovouci fadové ¢arce (F), s tim, Ze se
pripravuje nova verze s dal$imi rozsitenimi.

Tento simuldtor se zaméiuje na praci s kddem. Umoznuje kompilaci a simulaci velkych
souboru i slozek. Obsahuje podporu vypisu do konzole pomoci ecall RISC-V instrukce.
Navic umoznuje nastaveni parametri mezi-paméti, ale nezobrazuje informace o obsahu
mezi-paméti, pouze informuje zda byl piistup tspésny.

@ Jupiter — m] X

File Edit Run Settings Help

Editor Simulator

Registers Memory Cache

Address Machine Code Basic Code Source Code Block Size (bytes):

D 2x00010074 @x@2d58593 addi =11, x11, 61 la al, msg3 Number of Blocks:

O 9100010075 9100000073 ecall ecall Associativity:
a 2x0001067c 2x00100513 addi x10, xz0, 1 1i a@, 1 Cache Size (bytes):
O 2x0061 @050 AxPBA28503 addi =11, x5, @ mv al, t@
Accesses Hit Count
O @x88a10054 @xBBeARaTI ecall ecall 52 8
O 9100010055 9108200513 addi x10, x@, 18 1i a8, 1@

0x0001008c 0x00000073 ecall ecall

Console

Please enter a number: 7

The 7 fibonnaci number is: 13

Obrazek 4.5: Simulator Jupiter
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Uvedeny simuldtor se mtze hodit na zkoumani toku programu a vysvétleni programovani
v jazyku symbolickych instrukci RISC-V. Pro tucely této prace Jupiter ale nenabizi nic
uzite¢ného, co by jiz nenabizely dalsi simulatory.

4.2 Simulatory mezi-paméti

Vétsina simuldtori procesori, které jsem zde popsal, obsahovaly i mezi-paméti. Jelikoz se
tato prace zaméruje na pridani paméfového subsystému do simuldtoru procesoru, zaméril
jsem se i na simuldtory mezi-paméti. VSechny zkoumané simulatory, které v této Casti
popisu, pochézi z univerzit, coz muze znacit uziteénost grafickych simuldtoru pro vyuku.

4.2.1 Simulitor mezi-paméti z washingtonské univerzity

Webovy simuldtor [1] z washingtonské univerzity ma velmi jednoduchy vzhled, diky ¢emuz
se pouziva intuitivné.

r—Manual Memory Access: — History:
| Next | Addr: 0x 33

Addr: 0x

r— System Parameters:

Address width

R(©x13)
R(Bx33)
> R(Bx33)

Cache size: 4 Explain . Byte: Ox

Block size:

Associativity:
Write Hit:

Write Miss:
Replacement: |Least Recently Used v

| Resst System ‘

Index Offset
10 011 1

Cache Hits Cache Misses
2

Tag
001

r—Simulation M

Split address into TIO breakdown.
— Checking Set 2
LJExplain Looking for Tag 1... HIT in Line @!

VDT Cache Data

m =
K =

r

[Seles]
=

r

OOE=[—=[= == ===

Write back

OOE=—= === |

Write-allocate

[1[o[1[e3[dc[bB[7a[3b[1a[b2]0c] |

Physical Memory
0x00[20[fé6[efleala2[5e[9f[1a]

1:[a2]d0[4£[c4[a0]0c[£7]27]
0=10b8bd[1lalca[35[95[cb[80]

Ox

Eviction: LRU 0x12[84[3£]02[4f[8e[£3]£6]e5]

o[DOE = ] |:

Obrazek 4.6: Simulator mezi-paméti z washingtonské univerzity

Umoznuje nastavovani:

e Velikosti mezi-paméti a jejich bloki.

e Asociativity.

o Chovani pfi (ne)ispésném piistupu do mezi-paméti.
e Politiky vymeénovani: FIFO, LRU, Cyklicky.

Na zacatku je mozné si vybrat nastaveni mezi-paméti, a pak vygenerovat systém, coz nam
zaroven vygeneruje obsah paméti o velikosti adresniho prostoru, ktery byl zadan. Poté je
mozné provést ¢teni/zapis mezi-paméti nebo vymazani obsahu mezi-paméti. U generovani
i u pristupu do mezi-paméti umoznuje zadat, zda chceme vysvétlit, co mezi-pamét déla a
projit si jeji ¢innost krok po kroku. Navic obsahuje historii operaci coz umoznuje si piiklad
projit znovu.
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4.2.2 Simuladtor mezi-paméti z michiganské univerzity

Webovy simuldtor[7] z michiganské university na prvni pohled vypadd lépe. Tento simulator
nepracuje s daty, ale zaméruje se pouze na adresy. Umoznuje vytvaret jednoduchy kod, ktery
obsahuje pouze operace nacteni/ulozeni do paméti a cyklus for. VSechny bloky v paméti,
kterd méa 512B, jsou zbarveny stejnou barvou jako bloky v mezi paméti, takze je zfejmé
mapovani mezi bloky mezi-paméti a bloky paméti.

Instructions ? Cache ? Memory (512 B) ?

for i = 8:5 SEiD

for j = @:32 1
1d %32 + j INV INV NV NV
end
end
set1

NV INV NV NV
set2 5

INV INV NV NV °

INV INV NV NV

Cache Configuration ? # Hits #Misses

Custom v @ e
20 Array[1][J] (good) v 12

Block Size (B) # sets #Blocks/Set 13

8 v 4 v 4 v

Obrazek 4.7: Simulator z univerzity v Michiganu

Simulator umoznuje nastaveni:

¢ Velikosti a poc¢tu bloku.

e Asociativity.
Pri krokovani programu, vybrané misto v mezi-paméti blikne. Tento simuldtor pouziva
pouze LRU politiku vybéru obéti.
4.2.3 Simulator mezi-paméti z nanyangské univerzity

Webovy simuldtor[10] z nanyangské univerzity, ktery je mozné si prohlédnout na obrézku
4.8, umoznuje podobné nastavovani mezi-paméti jako simuldtor z washingtonské univerzity,
ale poskytuje vétsi vybér velikosti pameéti.

27



® FIFO OLRU
® Write Back © Write Through

® Write On Allocate O Write Around

22 Current Instruction (in
Hex)

e

fll

<= CACHE TYPE ANALYSIS

21 List of instructions (in Hex) | Split by comma
L72L-87.-91,542,576 L-d5 L-d8 56,545 L 9c L-24 597 S-29,L-41,L-a8 560 L-
75,L-10.L-38,5-b0,5-2f L-da,L-1e,5-97,L-db. S-2b,5-18,5-f4,L-52,5-b6.L-ed S-BLfB L-

Memory Size (power of 2) 256
Offact Bit = Gen. 88 Random Submit Next Fast Reset
setBis Instructions Instruction | Forvard
Cache 1
Size goben # 61 BB Cache Comparison
Cache 2 1. Direct Mapped Cache[8] HIT (2% MisS @l 1| ADD. RESOURCES (J248) NAND
Size (in hex) # 64 Instruction Breakdown
Cache 3 11 0 010
Size (nhex) # 128 [ 20t 3bit I 3 bit
— Cache Table
Cachel Tndex | Vald | Tag Data (Hex) Dirty B
Size (nnew) # 64 0 7 7l BLOCK 16 WORD0-7 0
[ Gen. Random Configuration g [ 1 EIOCK{SIWOHNIG ] o
z 7 0 BLOCK 12 WORD 0-7 [
[ Reset | Submit 3 1 0 BLOCK 3 WORD 0-7 0
List of Previous Instructions : 4 1 10 BLOCK 14 WORD 0 -7 0
+ Load 3F M| M M| M) 5 7 7 BLOCK 1D WORD 0-7 7
+ Store EE(MIMIM|M 5 7 T BLOCKE WORD 0-7 J
« Load1[M|M|M]|M] 7 1 01 BLOCKF WORD O -7 0
« Load 3E[H | H|H|H]
- Store BE[M|M|M|M] 2. 4-Way Set Associative Cache[2] HIT (6% MisS @l 1| ADD. RESOURCES (i) NAND
= Store GI[MIM|M|M]
+ Store 69[H|HIH|H] Instruction Breakdown
- Store EEMMIHIHIH] 1100 0 010
« Store 80 [M|M|M|M] —
- Load BF [HIH I H | H] [ Al [ il I Sl
+ Store 12[MIM MM Cache Table
- t“g ;:F[[: \:A"I'r \n':]'l rag Data [Dirty| Data [Dirty| idTeg Data [Dirty| Frag Data [Dirty]
+ Loa ( i (Hex)| Bi (Hex)| Bi (Hex)| i
. Store BT [M|M|M|M] (Hex)] Bit (Hex)| Bit (Hesx)| Bit (Hex)| Bit
+ Load BS[HIHIHIH] GIH EXIL BT BaC
+ Store 36 MM MM o1 |amwo]o 0|1 |wowo]o 0|1 |12woo o1 |swodo
« Load E9[H |H|H|H] 7 7 7 7
- Store TE[M|M|M|M] B3 B 19 53 BT
- Store CEH[HIHIH ool oo ol o W0
e 11 [1|wodo 1|1 |12 0 1]1[4wodo 1|1 [7|woqo
. Store BS[M|H|H|H] 7 7 7 T

« Load EE [H|M|H|M]
« Store DA [M| M| M| M]
« Load 67 [M| MM | M)

3. 2-Way Set Associative Cache[8]
Instruction Breakdown

HIT [39% MISS- |1 ADD. RESOURCES [§308) NAND
Obrazek 4.8: Simulator mezi-paméti z nanyangské univerzity

Stejné jako simuldtor z waschingtonské univerzity umoznuje krok po kroku vysvétlovat
¢innost mezi-paméti, ale barvy zobrazeni zplsobuji, ze vysvétlivky jsou nékdy necitelné.
Nicméné umoznuje zvoleni Ctyi mezi-paméti s riznymi konfiguracemi a porovnéni jejich
vykonu na stejnych datech, coz ostatni simuldtory nemaji. Navic je k tomuto simuldtoru
priloZena skvéla prezentace, kterda vysvétluje principy mezi-paméti a virtualni paméti.

4.2.4 Simulator mezi-paméti z brnénské univerzity

Webovy simuldtor z brnénské univerzity [12] (na obrézku 4.9), obsahuje jednoduchou malou
mezi-pamét s moznym nastavenim mezi:

e Piimo mapovanou.
¢ Dvou-cestnou.
e Plné asociativni.

Oproti predchozim simuldtorim ma&a jednoduché nastaveni i malou velikost, ale jeho
prednost spociva v ukazce funkcionality, kde mezi-pamét déla svoji ¢innost krok po kroku
se zvyraznénim pravé aktualizovanych blokt. Rovnéz obsahuje jednoduchy jazyk pro tvorbu
programi ukazujicich funkci mezi-paméti a nékolik ukizek zakladnich algoritmi, jako na-
priklad prochézeni matic.
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. . l l N RAM-ONLY DIRECT TWO-WAY

MEMORY CACHE CACHE

Pruchod matici po fadcich

ADDRESS DATA

ADDRESS V. TAG
ex0 (ooo) | T

T

ADDRESS V
e o0) | T e | [0,0,0,0]
T @ [0,0,00]

0 (NaN%)
0 (NaN%)

Obrazek 4.9: Simulator mezi-paméti z brnénské univerzity

4.3 Shrnuti

Ze vsech simulatort mé nejvice zaujal simulator RIPES, ktery obsahuje v podstaté vSechnu
funkcionalitu, ktera je cilem této prace, a jesté néco navic. Nejvétsi jeho nevyhodu pred-
stavuje, ze pro ucely predmétu AVS obsahuje prilis jednoduché procesory a ze je napsany
v ¢c++. Nicméné v dalsim pokracovani prace miize poslouzit jako dobré inspirace. Zaroven
po vyzkouseni simuldtorti mezi-paméti je ziejmé, ze piimé vysvétleni fungovani mezi-paméti
krok po kroku jiz také existuje. Pouze RIPES ale kombinuje oba pristupy dohromady.
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Kapitola 5

Superskalarni simulator od Jana
Vavry

V této kapitole se budu zabyvat praci Jana Vavry [16], na niz navazuje moje diplomova
prace, grafickym simuldtorem superskalarniho procesoru. Konkrétné se zamérim na funkci-
onalitu obsazenou v simulatoru a zpusob jeho implementace.

5.1 Prvni spusténi

Simulator lze stdhnout ze stranky uvedené v Readme souboru zdrojovych kéda tohoto
projektu. Nicméné v ramci prvniho spusténi jsem se rozhodl si simulator sestavit na svém
pocitac¢i, abych mohl pokracovat dale ve vyvoji. Simulator je implementovan v jazyce Javalb
v prostiedi Intellij-idea s grafickym prostredim implementovanym pomoci JavaFX16.

Béhem prvniho spusténi jsem narazil na fadu problémi, které vétsinou vzesly z toho,
ze jsem peclivé nenasledoval informace v Readme souboru, jelikoZz jsem je ¢asto Spatné
pochopil. V ramci prvniho spusténi jsem i tedy upravoval Readme soubor, aby bylo vice
jasné, jakym zpusobem lze tento program zprovoznit.

5.2 Pohled v hlavnim okné

Program se spusti v okné s propojenymi funkénimi jednotkami superskalarniho procesoru
(obrézek 5.1). Na levé strané se nachdzi prazdny kéd programu, ve vrchni ¢asti okna obsah
registri a nad nimi menu na spusténi simulace. Simulaci je mozné spustit na celém programu
nebo udélat pouze jeden krok. Zaroven umoznuje automatické krokovani simulace po case
zadaném uzivatelem, se zdkladnim nastavenim na jednu sekundu. Déle simulator nabizi
moznost délat i zpétné kroky.

5.3 Analyza funkci

Fungovani simuldtoru si lze vyzkouset na ukazkovych programech, které se nachazeji v menu
v sekci code—examples napsanych v jazyce symbolickych instrukei architektury RISC-V.
Umoznuje rovnéz ménit nastaveni simulace v menu simulation— configuration: Pocty funké-
nich jednotek, mnozstvi nac¢itanych a dokoncovanych instrukei, velikosti v prediktoru skokt
a velikosti reorder a Load-Store bufferu. Menu nastaveni je vyobrazeno na obrazku 5.2
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file Simulaton Code Help

I P oo v ) | P W g
£
Index Code Inzeger physical register | Ficating point physical register 2
g
¢ nop Eaiiaiian) Ll | oo raararial v gal o sraRtatia 2V Basieraatiarial aiial yanicrariiaraal v i RanizzaRiatial aial ot ancarnal i i 5
1D x0 0 x5 0 x10 ¢ x15 0 x20 [ x25 0 x30 [ g
02 nop x 5 a6 o a1 o x16 o =21 o x26 o 31 o L
03 nop 2 0 7 0 a2 3 17 0 22 3 27 0
0x4  nop 3 0 X8 0 x13 (i x18 4 x23 [ x28 4
0xs nop m o o o x4 3 19 o x4 3 x29 o
06 nop
0 nop
o6 nop Glabal history register
0 nop Bit vector
— 000000000
ba__nop Branch Issuc window Branch Function Units
b nop Cod Srctvalue | V1| Src2value | \2 7
ode ret value re2 value ranch targat buffor
oxe  nop Branch FU 1 Branch targat b
PCtag  Branch  Target
o nop
Oxe  nop Rename map table _ - —
G _|6eD Temp register Mapped register — —
000 nop
Alu Function Units
011 nop
02 nop ALU Issue window A1
013 nop Code  Srclvalie V1 Src2value V2 Operations
014 nop Pattern history table
015 nop | - v Index Prediction
0x16  nop - — — 0x0 Weakly Not Taken
017 nop oxt Weakly Not Taken
018 nop FP Function Units oo Weakly Not Taken -
019 nop 0 i 03 Weakly Not Taken
oxta |nop FP Issue window o Weakly Not Taken
axib [nop Code  Srclvalie V1| Src2value V2
e nop Decoce and Dispatch o
eorder buffer
oxtd nop Cade Renamed code
Code Valid Busy Spec
oxte  nop - - —
0af  nop L [
020 nop
01 nop

Obrazek 5.1: Hlavni okno simulatoru

Simulator také obsahuje moznost napsani programu v assembleru architektury RISC-V,
k ¢emuz se dostaneme po kliknuti na zalozku code v pravé ¢asti okna. Toto okno umoznuje
ulozeni a nacteni programu, otevreni vice zalozek s programy a preklad, nebo spise analyzu,
aktudlniho vybraného kédu. Priubéh analyzy se vypisuje v dolni ¢asti okna v sekci console,
kde se zobrazi fadky s chybami a informace o druhu chybu (napf. nezndmd instrukce).
Dostupné instrukce na dané architekture lze zobrazit v menu sekci help— Instruction list

5.4 Analyza kédu

Zdrojové soubory simulatoru se nachazi v repozitari ve slozce Source. V této slozce je mozné
najit:

o examples
o registers
e riscvisa
o gradle

e SIC

o testfiles

Prvni tfi z uvedenych slozek primo reflektuji sekce objevujici se v programu. Ve slozce
examples se nachazi ukazkové programy. Slozka registers obsahuje nastaveni celo¢iselnych
a desetinnych registrovych poli. A riscvisa obsahuje seznam podporovanych (RISC-V) in-
strukei s jejich zapisem v jazyce symbolickych instrukci, providénou operaci a typy ope-
randi. Pro sestaveni programu se vyuziva systém gradle. Tento systém zaroven pracuje se
slozkou testfiles pro automatické testovani.
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Simulation configuration

Loader || Buffers | Function Unit | Branching | Fetch and Commit

Register file folder location: Jregisters/ Browse
ISA folder location: Jriscvisal Browse
Confirm Cancel

Obrazek 5.2: Nastaveni simuldtoru

5.5 Zdrojové soubory

Hlavni ¢dst implementace se nachazi ve slozce src/main/java/com.gradle.superscalarsim.
Slozka obsahuje:

o blocks - implementace funkénich jednotek (ALU, FPU, Branch a L/S).
e code - parser a interprety kédu.

o di - vklddéni zavislosti (dependency injection).

e enums - enumerace a dalsi definice.

e loader - nac¢itani hlavniho okna, registri a instrukei.

e models - Soubory s tifidami, které obsahuji a predavaji stav simulace.

e ui - grafické rozhrani simulatoru.

e SimulationMain - hlavni tiida simulatoru.

Kéd je prehledné rozdéleny do souborti, kde kazdy soubor obsahuje jednu tiidu a ty obsahuji
vSechny potfebné funkce pro pfistup k vnitfnim proménnym a praci s nimi. Zaroven kéd
obsahuje komentare ve stylu pro Doxygen.
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Kapitola 6
Navrhy rozsireni

Pro lepsi vyuziti v rdmci predmétu AVS navrhuji rozsitit simuldtor o lepsi praci s paméti.
Hlavni ¢ast bude predstavovat pridani mezi-paméti. Mezi-pamét si zaroven bude sbirat své
statistiky a tim se rozsiri funkcionalita sbéru statistik. Pro lepsi vysvétleni prekladact, a
hlavné jednodussi tvorbu ukazkovych prikladi, by mohl simulator prijimat program v jazyce
C nebo jemu podobném.

6.1 Hlavni okno

V hlavnim okné, jehoz ndvrh znazornuje obrazek 6.1, bude minimalni rozdil, konkrétné
pujde o pridani tabulky X poslednich pristupt do paméti a zdlozek mezi-paméti a statistik.

File [Simulation] Code [ Help |

LN

Integer registers FPU registers s
ox140|  faddf1 23 x0 0 x5 54665 x10 0 x15 0 x20 0 x25 0 x30 0 =
x1 451623 x6 0 x11 0 x16 0 x21 0 x26 0 x31 0 ‘%
0x144 sub x5 x1 x3 x2 -456 x7 0 x12 0 x17 0 x22 0 x27 0
x3 654 x8 0 x13 0 x18 0 x23 0 x28 0
0x148|  addx6x5x1 [Ty 5 X9 0 x14 0 x19 0 x24 0 x29 0 [e
5
0x152| bnz x6 x0 error S
0x156|  fmul f1 1 3 [ ——
. | fadd 1819110 [0
0x160| addi x6 x2 0x234 i
0x164 | addi x7 x6 0x234 T T
o
0x168 bne x7 x1 tag "‘mmﬂj
i
0x172|  add x1 x2 x3 ©
N PN e daxies M
0x176| addi x5 x2 0x16 }{L Y TR N —— ’—2‘
jump addr | st /
0x180|  fadd f2 f3 f4 v X Last accessed
0x184 nop S — 0x450 | Ox1354abbb
0x188 nop a2 0x454 | 0x1999aaac
0x192 J 0x458 | Oxbbdd9713
X' nop -
C 0x1000| Ox5accccee
0x196 nop oot
e
0x200 nop T
scararmii
0x204 nop bz 40 0648
0x208 nop
0x212 nop
0x216 nop

Obrazek 6.1: Pohled do hlavniho okna

Zobrazeni celé paméti v hlavnim okné simulace by zabiralo moc mista nebo by bylo
neprehledné. Zobrazujici komponenta by navic musela umeét zpracovat data paméti i z mezi-
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paméti a zobrazit jen ty nejaktualnéjsi. Proto jsem se radéji rozhodl implementovat piistup,
kdy budu ukladat pouze posledni dokoné¢ené piistupy do paméti. Cimz bude lépe vizuali-
zovan chod programu. Data v této tabulce budou sefazena podle adresy a posledni pristup
bude podbarveny, aby bylo zfejmé, ktera adresa se zménila.

Pro tuto tabulku budu ziskavat data z dokoncenych instrukci. Ta si navic bude muset
pamatovat sviij predchozi obsah pro moznost zpétného krokovani, coz pujde implementovat
jednoduse zasobnikem.

6.2 Navrh mezi-paméti

Rozsiteni simulatoru o pamétovy subsystém bude spocivat hlavné v implementaci mezi-
paméti. Mezi-pamét bude v ramci simuldtoru umisténa na vlastni zalozce. V ramci tohoto
okna budou zobrazeny také L/S Buffery z Load/Store jednotky ! a tabulka s paméti.

File |Simulation| Code | Help |
S
> MO s
©
0x140 | fadd f1 23 L 2
oad Buffer Store Buffer E
Tag Index | Offset 7]
0x144 sub x5 x1 x3 PC Address | Size PC Address | Size Data
1 Ox6c 4 1 0x100 2 0x45ab
Ox148 | add x6 x5 x1 | —>| 0000000000000000000000000 | 110 1100
0x152 | bnz x6 x0 error
0x156 |  fmul f1 1 3 )
0x160 | addi xB x2 0x234 Index] Valid | Dirty Tag Block0 Block1 Block2 Block3
0x164 | addi x7 x6 0x234 000 1 1 |0000000000000000000000011] 0x15ac9314 | 0x15ac9314 | Ox15ac9314 | Ox15ac9314
0 0
0x168 bne x7 x1 tag
001 1 1 |0000000000000000000011011| Oxcab51348 | Oxaff155656 | Oxbbbabbab | Oxdddddddd
0x172 | add x1x2x3 1 0 |0000000000000000000001010| Ox1abcdef23 | Oxadfadfa11 | 0x9a9a9a9a | 0x111111111
0x176 | addi x5 x2 0x16 010 -2
0 0 —]
0x180 | fadd f2 3 f4 0 0
011
0x184 nop 0 0
0 0 ]
0x188 nop 100 0 0
0x192 noj 0 0
i 101
0 0
0x196 nop
1 0 |0000000000000000000000011| 0x22222222 | 0x12334455 | 0x15ac9314 | 0x15ac9314
—>{ 110
0x200 nop 0 0
0x204 111 0 0
X no|
P o | o | |
0x208 nop
0x212 nop
0x216 nop l

Obrazek 6.2: Navrh mezi-paméti

Implementace mezi-paméti bude podporovat Siroké nastaveni pro moznosti pokusu nad
danym kodem. Konkrétné se bude jednat o:

e Velikosti: pocet blokii a velikost jednoho bloku 2.
e Asociativitu: moznost nastaveni na nasobky 2.

o Pristup k hit/miss zapisu.

'Pro jednoduchost zobrazeni a jednodussi implementaci bude mezi-pamét podporovat pouze jednu Lo-
ad/Store jednotku. Toto by nemélo omezit hlavni cil rozsiteni, tedy vysvétleni fungovan{ mezi-paméti a jak
by s nimi mély programy pracovat.

2Potit4 se s tim, ze pro velké velikosti bude zobrazeni nepfehledné. V tomto piipadé jiz nebude potieba
potieba zkoumat mezi-pamét samotnou, ale spiSe jeji statistiky.
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6.2.1 Integrace do kédu

Definice tfidy mezi-paméti by méla byt vlozena ve zdrojovém kdodu ve slozce blocks podobné

jako jiné jednotky. Implementaci svych funkci bude mit ve slozce code. Mezi-pamét ale ne-

bude nic interpretovat, takze oproti jinym jednotkdm nebude mit soubory pro interpretaci.
Tato jednotka bude obsahovat funkce:

e Ulozit data: Adresa, sitka.
e Nacist data: Adresa, siika.
e Simulovat zpét.

o Ziskat statistiky.

o Ziskat obsah.

Mezi-pamét bude mozné simulovat dvéma zpusoby. V hlavnim okné simulace se bude
chovat jako pamét a pouze vrati data a zpozdéni zpusobené timto pristupem (stdle si
bude sbirat statistiky). P¥i pfepnuti do okna mezi-paméti bude umozrovat krokovani. Toto
krokovani bude fizeno z okna simulace mezi-paméti, kterd bude vykreslovat jeji ¢innost.

Napojeni tfidy mezi-paméti do kédu simulatoru bude na stejném misté, jako je v tuto
chvili napojend pamét.

6.3 Prekladac

Rozsiteni zdlozky code bude spocivat v prekladaci z vyssiho programovaciho jazyka do
jazyka symbolickych instrukci. Konkretné jsem volil mezi dvéma moznostmi:

o Bézné pouzivané prekladace (napf. Clang, gce).
e Vlastni prekladac z jazyka podobného C.

Hlavni prednost, kterou by mél preklada¢ umét, predstavuje podbarveni kazdé dile-
zité ¢asti kodu stejnou barvou ve vyssim programovacim jazyce i ve vygenerovaném ja-
zyce symbolickych instrukci. Duvodem je lepsi vysvétleni ¢innosti prekladace a jednodussi
porozumeéni jaké operace musi procesor udélat pro vykonani daného programu. Piiklad
jednoduchého programu s jednim cyklem si lze prohlédnout na obrazku 6.3.

Bézné pouzivané prekladace

Bézné pouzivané prekladace umoznuji vybér cilové architektury a vygenerovani assembleru,
coz by umoznovalo pripadnou podporu vice architektur nez RISC-V. Nicméné, aby cely
simulator podporoval jiné jazyky, je potfeba také definovat interpretaci téchto instrukeci,
kterd je jiz definovana pro RISC-V. Zaroven by bylo potieba vygenerovany ASM soubor
jesté zpracovat kvili spravnému podbarvovani textu a odstranéni nadbytecnosti, které si-
mulator nepotrebuje nebo nepodporuje, pricemz by toto nejspise bylo ¢aste¢né jiné pro
kazdou architekturu.
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File [Simulation] Code [ View [ Help |

[T T°1 6
o
code.cc X | [code.out.rv_X] 2
2 2
3 for (inti = 0; i<5; i++) { 3 addi t1, x0, 0
2 | mesum 4 [addi2 05 s
5 5 label forloop1_start: [
6 _ 6 bge t1,t2, forloop1_end (&)
7 |} 7 |addt0,t0,t1
8 addit1, t1, 1
9 9 j forloop1_start
10 10 |label forloop1_end: o
11 1" r S
12 12
13 13 | IS
14 14 n
15 15 £
16 16 £
17 17 ]
18 18
19 19
20 20
21 21
22 22
23 23
24 24
25 25
26 26
27 27
Compiling ...
Error at line 5: Missing ;
Stop compiling.
Compiling ...

Success!

Obrazek 6.3: Navrh prekladace

Vlastni prekladac

Oproti tomu vlastni preklada¢ umozni pfirozené propojeni piekliadaného a prelozeného
kédu. Dalsi velka vyhoda vlastniho prekladace by mohla byt moznost podpory témér ja-
kékoliv architektury. Zaméreny bude na RISC-V, ktery je v soucasnosti v simuldtoru im-
plementovan. Pri definici vlastnich instrukei, by mély byt pouzity automaticky. Posledni
vyhodu tohoto feseni predstavuje jeho prenositelnost na jiné systémy.

Vybér prekladace

Je samoziejmé, Ze bézné pouzivané prekladace zvladnou vyprodukovat kvalitnéjsi kod nez
vlastni prekladac, nicméné cilem neni vyprodukovat co nejlepsi kod, ale vysvétlit jeho fun-
govani. A proto z diivodu vétsitho mnozstvi vyhod zvolim vlastni piekladac.

6.3.1 Definice jazyka

Podpora celého jazyka C by byla zbyteéné naro¢na a prinesla by malo uzitku navic. Z toho
duvodu je potfeba vybrat dulezité aspekty jazyka C. Ofezané C bude podporovat:

e typy: int, float

e Tizeni: for, while, if-then-else

o operace: +,-,%,/.%, », »>, «, <, >, ==, >=, <=, |=

o funkce

e main: musi byt implementovan, nepodporuje argumenty

e 1D pole se statickou sirkou
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6.3.2 Integrace do kédu

Integrace do kédu bude pomérné jednoduchd, protoze pouze rozsifim funkcionalitu sou-
¢asného prekladace. Konkrétné rozsitim zobrazeni v ui/code WindowController a samotnou
funkcionalitu v ¢asti code — hlavné v CodeParser.

6.4 Statistiky

Rozsiteni o mezi-pamét s sebou prinasi dalsi statistiky, které je mozné, a dokonce vhodné
sbirat. Pro lepsi zobrazeni statistik vznikne nova zalozka Statistics. Zde budou statistiky
z procesoru, které jsou jiz v simuldtoru, a navic nové statistiky z mezi-paméti. RIPES [11]
simulator obsahoval vyobrazeni stavu mezi-paméti v Case do grafu, coz mé velmi zaujalo,
protoze se jedna velmi uzite¢ny zpusob vizualizace statistiky, tudiz grafy také zahrnu do
statistik. Navrh vzhledu statistik si muzete prohlédnout na obrazku 6.4.

File [Simulation] Code [ Help |
Core statistics Average memory access time (last 5 accesses)
CPI 0
2
Clock Cycles 0 3
Commited instructions 0 .
g
O
Branches 0
8
Prediction Accuracy 0 g
Cache statistics Cache capacity usage
Accesses 0
Hits 0
Misses 0
Average delay 0
Total delay 0

Obrazek 6.4: Navrh statistik
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Kapitola 7

Implementace prekladace

Nejprve jsem se rozhodl implementovat prekladac, protoze nejméné zasahuje do aktualniho
kédu. Pro pridani prekladace bylo potieba upravit aktualni funkcionalitu prekladace, ktery
v soucasnosti kontroluje, zda kod spliuje syntax symbolickych instrukci. Déle bylo potreba
upravit grafické rozhrani.

7.1 Hlavni logika

Pri spusténi prekladu se vytvori tiida prekladace a preda se ji zdrojovy soubor, ktery ho
bude zpracovavat syntaxi Fizenym prekladem (stejné jako bylo vysvétleno v kapitole 3).

Hlavni komponentu v tomto ptripadé tvori Syntakticky analyzdtor 7.3, ale implementaci
komponent popisu podle postupu zpracovani vstupniho programu.

7.2 Lexikalni analyzator

Lexikalni analyzator prijme cely soubor, zpracovava ho a postupné ho rozdéluje na lexémy.
Konkrétné dostane jiz zpracovany soubor nacteny po radcich do pole fetézcu. Trida Com-
pilerParser obsahuje funkce:

o New: (String[] vstupni soubor)
o GetNextToken: (),(Token)

Jeho hlavni prace spociva ve funkci GetNextToken, ktery zpracovava vstup nasledujicim
zpusobem:

o Bilé znaky: Oddélovac, posle se jako token, vice bilych znaki za sebou se odstranuji.

o Specidlni znaky (/,*,+,-,%,&,|,!,.=,(,),;,[,],,): Oddélovag, posle se jako token, posila se
kazdy znak.

o Ostatni znaky: Posilaji se jako celé slovo, hranice urc¢uji oddélovace, nebo konec/za-
catek radku.

7.3 Syntakticky analyzator

Syntakticky analyzdtor je hlavni komponentou ridici cely preklad. Z tokeni, které ziskava
z lexikdlniho analyzdtoru, se postupné vytvari syntakticky strom.
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Vzdy, kdyz se dokonéi podstrom az na listy (jeden prikaz), predd se dany podstrom
sémantickému analyzdtoru. Ridici prvky se poslou k sémantické analyze, bez zpracovaného
podstromu. Tedy v piipadé Fidicich ptikazu (If, While, For) a funkeci se pfedd oddélené
Fidici ¢ast a télo.

Podstrom doplnény o informace ze sémantického analyzdtoru se dale predd generatoru
triadresniho kédu.

Dokonéeny program se preda generatoru cilového kédu, ktery cely program pievede na
cilové instrukce a vytvori jejich finalni sekvenci.

Trida syntaktického analyzatoru obsahuje:

o New: (Lexikdlni analyzdtor, Sémanticky analyzator, Generédtor tii adresného kddu,
Optimalizétor, Generator kddu cilové architektury)

o Compile: (), ((String, Integer)[] Code)

7.3.1 Syntakticky strom

Syntakticky strom ma tyto vlastnosti:
o Koren: Vse definované v této ¢asti je globalni.
o Kazdy uzel obsahuje ¢islo fadku, typ uzlu a hodnotu.
¢ Neomezeny pocet podstromu.
o Kazdy uzel obsahuje odkaz na nadfazeny uzel, kromé kotene.
e Listmy jsou jednotlivé Tokeny a v pripadé ridicich prvka jeho c¢asti.
o Kazdy uzel obsahuje vygenerovany kod v tomto uzlu.

Hodnota v uzlu stromu je poradi fidiciho prvku, v pripadé listu konkrétni token.

7.3.2 Prabéh syntaktické analyzy

Vétsinu druhti piikazt je mozné rozlisit jiz podle prvniho slova v piikaze. Podle prvniho
slova se tedy vybere, jaky druh prikazu se zpracovava.

Zpracovani ridiciho prikazu

Zpracovani fidictho piikazu se ¥idi podle toho, zda se zpracovava cyklus For nebo ne.
7 pohledu spravnosti syntaktické analyzy neni rozdil mezi prikazy If a While. Pro analyzu
jednotlivych c¢asti se vyuziva funkce zpracovani prikazu a zpracovani definice, které jsou
vysvétleny dale.

Zpracovani definice proménné nebo funkce

Podle tretiho tokenu je mozné rozlisit, zda se zpracovava definice funkce nebo proménné,
pripadné, zda jde o definici pole. Obrazek 7.1 zobrazuje graf zpracovani proménné a funkce.
Na obrazku 7.2 graf pokracuje zpracovanim definice pole.
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Ziskej dalsi token
(identifikator)

v Bilé znaky (mezery) se ignoruji
[Zl’skej dalsi tokenj
Token je ( .
Zpracovava se funkce | Tokenje [ 4 Zpracuj definici M
d pole
Token je =
\ Zpracovava se proménna (- L e
~ » Zpracuj prikaz
Ziskej dalsi token ] \ Y,
(typ argumentu)J Tokenje; L
¢ Zpracovava se proménna Zkontroluj ,
~ |_> sémantiku( pokud
Ziskej dalsi token Token je , se nezpracovava
(nazev argumentu)} Zpracovava se proménna \definice uvnitf for)
\ 4 A
. ~ | Ziskej dalSi token Zmén stav na
Ziskej dalsi token | | (h37ev proménné) ) nadfazeny piikaz
(Oddélovad) Token je, ¢

Token je , . . ‘
A 4 Token je ; Token je =

Ziskej dalsi tokenw A
(Oddélovag) J

Token je ) Zkontroluj

Obrazek 7.1: Syntaktickd analyza definice proménné nebo funkce

Zpracovani prikazu return

Prikaz return se zpracovava velmi jednoduchym zpiisobem, zavolanim zpracovani bézného
prikazu.

Zpracovani prikazu else

Zkontroluje se, zda aktudlni stav zpracovavani programu je uvnitt prikazu If (tedy, ze jiz
byla dokoncena vétev then). V takovém pripadé se nastavi aktudlné zpracovavany prikaz
na If-else.

V piipadé, Ze se nachazime ve stavu If (a oc¢ekava se else) a piikaz else neprijde, piikaz
If se ukondi a presune se zpracovavani na nadrazeny prikaz.

V pripadé, Ze se objevi prikaz else v jiném stavu nez If, vyvola se chyba prekladu.
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(Ziskej dalsi token\
L (velikost pole) )

v

(Ziskej dal&i token |  Bilé znaky (mezery)

L (i) ) se ignoruji
s a
Ziskej dalsi token
\ Y,
Token je ;

Token je = A
A

Ziskej dalSi token
()

A
[Zl’skej dalsi token

(konstanta)

J

Nebyly definovany
vsechny hodnoty

v .
Ziskej dalsi token Token je,
(Oddélovac)

!

Byly definovany

vsechny hodnoty \(Zl’skej dalsi token
'k (Strednik)

Token je }

Obrazek 7.2: Pokracovani syntaktické analyzy definice pole

Zpracovani bézného prikazu

Zpracovani bézného prikazu si ukldda aktualni stav zpracovavani, ktery urcuje jaky token
je povoleny jako dalsi. Kazdy token se vklada do aktudlniho stromu jako dité. Z tokent se
tedy utvoii pole. Detailné postup ukazuje v grafu 7.3.



Hodnota v tomto grafu mize znamenat
konstantu i proménou - pro syntaktickou
analyzu v tom neni rozdil

Ma vstup funkce token?

Dalsi token musi byt: DalSi token musi byt:
Hodnota nebo rozdélovac Operace nebo rozdélovac

[ |
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Nacti token >
—J zavorka

\4
Dalsi token musi byt:
Hodnota nebo zavorka

Nékteré stavy jsou jesté detailnéji omezené,
ale nelze v&e zahrnout do diagramu
kvuli neprehlédnosti, kterou by to zpUsobilo.
Napfiklad pocitadlo zavorek nebo omezeni pfifazeni
pouze jako druhy token nebo paty v pfipadé pole

A
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Token je /*+-%&"|<>=
takovy token.

Operace
muze byt dals$i
token

MUzZe byt operace tvorena
dvéma tokeny (napf. >=)

Dal$i Token musi byt:
Hodnota nebo zavorka

Pokud pfedchozi nebyl
takovy token.

ERROR [ Dalsi Token musi byt:

Hodnota nebo zavorka

Token je [1()

Zavorka muze byt
dalSi token a je umoznén
dany typ

ERROR

Dalsi Token musi byt: Dal&i Token musi byt:
Operace nebo = (Zavisi na
operaci),

hodnota nebo zavorka

[: Hodnota
(: Hodnota nebo zavorka
)1: Rozdélovac nebo
zavorka nebo operace

POZOR
) je ve dvou vétvich

\4

oken neni ) nebo
pocet rozpracovanych
zavorek je 0

Rozdélovaé
muZe byt
dalSi token

Token je ,);

oken je nastaven
jako koncovy

[

—

Dalsi Token musi byt:
Hodnota nebo zavorka

A

Token je
jina hodnota
nebo !~

oken je ,
avola se
funkce

Token musi byt
= hodnota nebo
zavorka

Hodnota
muzZe byt dalsi
token

Token musi byt
operace hodnota
nebo zavorka

Dal$i Token musi byt:
= hodnota nebo zavorka
Dalsi Token musi byt:
hodnota

ERROR [ Dal&i Token musi byt: j

Operace nebo zavorka Foken musi byt

hodnota nebo
oddélovaé

Hodnota nebo zavorka

|

Obrazek 7.3: Syntakticka analyza piikazu

[ Dalsi Token musi byt: ]

Na konci vytvoreni piikazu se aktualni stav presune na nadrazeny prvek. Pokud se
zpracovava piikaz v rdmci jiného piikazu (if, while, for, return, definice), nevyvola se zpra-
covani syntaktické analyzy. Pokud je to uvnitf téla programu, vykona se Sémantickd analyza
a zpracovavani se presune na nadiazeny ridici prvek.
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Zpracovani slozené zavorky

V pripadé oteviraci slozené zavorky { se zkontroluje zda aktudlni stav umoziuje vice pod-
prikazu zabalenych pod slozené zavorky a v piipadé zZe ano, nastavi se priznak zpracovavani
vice ptikazt. Pokud jiz byl priznak nastaven, vyvola se chyba prekladu.

V piipadé uzaviraci slozené zavorky } se zkontroluje priznak zpracovavani vice prikazi.
Pokud je nastaveny, ukon¢i zpracovavani aktualné zpracovavaného ridiciho prvku a presune
se na nadrazeny piikaz. Pokud pfiznak nastaven nebyl, vyvola se chyba prekladu.

7.4 Sémanticky analyzator

Sémanticky analyzator zpracovava prichozi podstromy, kontroluje datové typy, definici pro-
ménnych a funkci a prichoz{ strom transformuje do hierarchie naptiklad podle priority
operaci.

Z toho divodu si udrzuje t¥i rozmérnou tabulku symboli:

e 1. rozmér: ID nadrazeného uzlu: urc¢uje rozsah proménnych.
e 2. rozmér: Nazev proménné.

e 3. rozmér: Typ proménné, ID uzlu proménné.

Déle si udrzuje dvourozmérnou tabulku funkei:

e 1. rozmér: Nazev funkce.

e 2. rozmér: ID uzlu, typ vystupu funkce, typy vstupt funkce.

7.4.1 Sémanticka analyza ridiciho prikazu

Zpracovani ridiciho prvku vyuziva zpracovani definice i prikazi a stard se pouze o spravné
vytvareni podstromd.

\l/ Zpracovava se

Zpracovava se For (PFe(':ti typ kofene If nebo While
k podstromu
A 4

Predi typ prvnl'how Podstrom je definice promé&nné
podstromu J

A\ 4

onvds'trovr’n je Zpracuj definici
y_béZny pfikaz proménné v prvnim
Zpracuj ptikaz v podstromu

prvnim podstromu

v

Zpracuj prikaz v
druhém podstromu

Zpracuj pfikaz
» (For: Treti
k If, While: Prvni)

Obrazek 7.4: Sémanticka analyza tidictho prikazu
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7.4.2 Sémanticka analyza definice proménné

Sémantickd analyza pri definici proménné zkontroluje, Zze proménna jiz neni definovana
v daném kontextu, a typ prirazované hodnoty, poté si proménnou ulozi. Presnéji sémanticka
analyza postupuje podle grafu na obrazku 7.5, zpracovani definice pole déale pokracuje podle
grafu na obrazku 7.6

Ziskej datovy typ
z prvniho prvku

Zkontroluj treti
prvek

Pfidej pole do tabulky
proménnych.
Jméno je druhy pvek
Velikost je Ctvrty prvek

Bylo
definovano
pfifazeni

[PFeéti dalsi hodnotu]«

Zpracuj pFifazeni
do pole

Zpracovali
jsme vsechny

prvky \ 4 .
Zkontroluj typ
hodnot
Pfidej proménnou do v
tabulky proménnych. [Vygeneruj 0 jako]
Ziskej daldf prvek Jméno je aktualni prvek véechny hodnoty ) <
(pocinaje druhym) 7 Pfidej hodnotu do
pole hodnot

Jesté nebyly
zpracovany viechny
hodnoty?

Zkontroluj Ze typ
prikazu odpovida
typu proménné

Zpracuj pfifazeny
prikaz

Obrazek 7.5: Sémantické analyza definice pro- Obrazek 7.6: Pokracovani sémantické
meénné analyzy prirazeni definice pole

7.4.3 Sémanticka analyza definice funkce

Pri definici funkce sémantickd analyza zpracuje vSechny typy a ndzvy vstupnich argument,
ulozi si poradi v argumentech a navratovou hodnotu funkce. Presnéji probiha tato analyza
podle grafu na obrazku 7.7
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Ziskej datovy typ
z prvniho prvku

Ziskej jméno
funkce z druhého
prvku

Y

Pocinaje ¢tvrtym
prvkem:

A
)
{

Jesté nejsou
zpracovany vsechny
prvky

Pridej si typ vstupu Pridej si typ vstupu
z jednoho prvku z druheho prvku

Pfidej funkci do w . .

tabulky funkci J

Obrazek 7.7: Sémanticka analyza definice funkce

7.4.4 Sémanticka analyza prikazu

Sémanticka analyza piikazu predstavuje stejné jako u syntaktické analyzy nejslozitéjsi ¢ast
na sémantické analyze. Analyzator v této ¢asti kontroluje typ prikazu a transformuje vstupni
pole tokeni na strom podle priority operaci. Vysledny podstrom ma v kofenu operaci, ktera
se provede jako posledni. Blize k listiim se nachazi hodnoty a operace, jez se provedou
drive. Zpracovani sémantické analyzy piikazu (bez vytvoreni stromu operaci) je na grafu
na obrazku 7.8.
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. Hodnota v tomto grafu miZe byt proménna i konstanta

Rekurzivné
zpracuj
index pole

Prikaz
obahuje vice
jak 1 prvek

Pfikaz obsahuje
vice jak 3 prvky a
druhy prvek je '
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nového stromu:
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Zkontroluj
jestli dalSi prvek
je'=

Musi dalsi
zpracovavany prvek
byt hodnota nebo
zavorka?

Zkontroluj
dalsi prvek

Rekurzivné zpracuj
pFifazovaci pfikaz do
druhého ditéte a
zkontroluj zda je to
spravny typ pfikazu

i
<

Cyklus se
provadi
dokud jsou —)[ Prvek je '(' J—)[Zvedni poditadlo zavorek
dalSi prvky
PFidej novy typ jako
—)E’rvek je typova konverze aktualni s aktudlnim

pocétem zavorek

—)[Prvek je unarni operace]—)[PrICIeJ prlv_ek € Stmm.“
operaci jako operaci

l Prvek je hodnota ] Proménna i funkce mohou
obsahovat stejné znaky

Prvek je
proménna

Zpracuj volani funkce Rekurzivné
a zkontroluj typ zpracuj
navratové hodnoty index pole

konstanta

Y

Zkontroluj | v \4
dalsi prvek |

—)[ Prvek je 'l', nebo ', J—)O
Prvek je ')’ Pogcitadlo
zavorek je rovno

nule
Neni dalsi prvek:
Operace je null

—)[Prvek je jina operaceJ Dalsi prvek musi byt:
¢ Operace, nebo zavorka,
nebo oddélovac
Dalsi prvek musi byt: W y N
Hodnota nebo zavorka J g
A4

Pokud je poditadlo zavorek stejné jako pro aktualni PFidej hodnotu i operaci
typ operace, ziskej nadfezeny typ operace do nového stromu

Obrazek 7.8: Sémanticka analyza piikazu
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7.5 Generator tri-adresného koédu

Syntakticky podstrom s doplnénymi informacemi od syntaktické analyzy se predd generd-
toru t¥i-adresného kédu, ktery dany podstrom (pfikaz) pfevede na posloupnost tri-adresnych
operaci. Konkrétné se jedna o tyto operace:

o Load TargetReg (AddressReg + offset)
o Store (AddressReg + offset) SourceReg
o Arithmetic TargetReg=Sourcel operace Source2
e Label Name
e Branch (Podminka) TargetLabel
e Jump TargetLabel
e Loadlmm Registr Hodnota
e Zalohuj registry
e Obnov registry
Vsechny tyto operace navic obsahuji:
o Typ vstupu a vystupu
« Cislo tadku z kterého byl pifkaz vygenerovin
o Velikost proménné (pole)

« Poradi argumentu funkce (0 pokud to neni argument, -1 pro posledni argument)

7.5.1 Pseudokédy prevedeni operaci do vnitrni reprezentace:

VYGENEROVANA INICIALIZACE CYKLU - Pouzij docasny registr
podminka_cyklu:
VYGENEROVANA PODMINKA CYKLU - Pouzij docasny registr
branch (Neplati podminka) konec_cyklu
VYGENEROVANE TELO CYKLU - Pouzij docasny registr
VYGENEROVANY KONEC CYKLU - Pouzij docasny registr
jump podminka_cyklu
konec_cyklu:

Vypis 7.1: Pseudokdd cyklu For prevedeného vnitini reprezentace

podminka_cyklu:
VYGENEROVANA PODMINKA CYKLU - Pouzij docasny registr
branch (Neplati podminka) konec_cyklu
VYGENEROVANE TELO CYKLU - Pouzij docasny registr
jump podminka_cyklu
konec_cyklu:

Vypis 7.2: Pseudokéd cyklu While prevedeného do vnitini reprezentace
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VYGENEROVANA PODMINKA IFU - Pouzij docasny registr
branch (Neplati podminka) vetev_else
VYGENEROVANE TELO VETVE THEN - Pouzij docasny registr
jump konec_ifu
vetev_else:
VYGENEROVANE TELO VETVE ELSE - Pouzij docasny registr
konec_ifu:

Vypis 7.3: Pseudokdd piikazu If-then-else prevedeného do vnitini reprezentace

VYGENEROVANA PODMINKU IFU - Pouzij docasny registr
branch (Neplati podminka) konec_ifu
VYGENEROVANE TELO VETVE THEN - Pouzij docasny registr
konec_ifu:

Vypis 7.4: Pseudokdd piikazu If-then prevedeného do vnitini reprezentace

VYGENEROVANY PRIKAZ NAVRATOVE HODNOTY - Pouzij navratovy registr
jump konec_funkce_<nazev>

Vypis 7.5: Pseudokéd prikazu Return prevedeného do vnitini reprezentace

funkce_<nazev>:

Zazalohuj registry

VYGENEROVANE TELO FUNKCE - Pouzij docasny registr
konec_funkce_<nazev>:

Obnov registry

Obnov Stackpointer

jump navratovyRegistr

Vypis 7.6: Pseudokdd funkce prevedené do vnitini reprezentace

funkce_main:

VYGENEROVANE TELO FUNKCE - Pouzij docasny registr
konec_funkce_main:

jump konec_programu

Vypis 7.7: Pseudokdd funkce main prevedené do vnitini reprezentace

For (Vsechny vstupni hodnoty):
VYGENEROVANA INICALIZACNI HODNOTA - Pouzij docasny registr
For(Vsechny nazvy promennych) :
Store (promenna) docasnyRegistr

Vypis 7.8: Pseudokéd definice proménné prevedené do vnitini reprezentace

function generovaniPrikazu(cilovyRegistr, aktualniUzel):

Switch (Typ uzlu):
Prikaz nebo zavorka:
Rekurzivne zpracuj dite
Konstanta:
//Nacti konstantu
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LoadImm cilovyRegistr hodnotaUzlu
Promenna:
//Nacti promennou z jeji adresy
Load (promenna) cilovyRegistr
Pole:
Rekurzivne zpracuj index - Pouzij docasnyRegistr
// Vynasob index velikosti datoveho typu (zatim pouze int a float)
Mul docasnyRegistr * 4
//Nacti prvek pole z jeho adresy

Load (promenna+docasnyRegistr) cilovyRegistr
Operace:

If (binarni operace):
Rekurzivne zpracuj ditel - Pouzij docasnyRegistril
Rekurzivne zpracuj dite2 - Pouzij docasnyRegistr2
//Proved binarni operaci
Operace cilovyRegistr docasnyRegistrl docasnyRegistr2
else:
Rekurzivne zpracuj dite - Pouzij docasnyRegistr
//Proved unarni operaci
Operace cilovyRegistr docasnyRegistr
Prirazeni:
Rekurzivne zpracuj dite2 - Pouzij docasnyRegistril
Ziskej promennou z ditel
If (Promenna je pole):
Rekurzivne zpracuj index - Pouzij docasnyRegistr2
// Vynasob index velikosti datoveho typu
Mul docasnyRegistr2 = docasnyRegistr2 * 4
//Uloz hodnotu na adresu promenne
Store (promennatdocasnyRegistr2) docasnyRegistril
else:
//Uloz hodnotu na adresu promenne

Store (promennatdocasnyRegistr2) docasnyRegistril
Zavolani funkce:

For (Vsechny argumenty):
Rekurzivne zpracuj argument - Pouzij docasnyRegistr
// Uloz argument na vrsek zasobniku

Store (stackpointer+vrsekZasobniku) docasnyRegistr
//Zazalohuj zasobnik

Store (stackpointer+vrsekZasobniku) stackpointer
//Posun zasobnik

Add stackpointer=stackpointer+vrsekZasobniku
//Skoc na funkci

jump funkce

//Presun hodnotu do spravneho registru

move cilovyRegistr navratovyRegistr

Vypis 7.9: Pseudokdd prevedeni piikazu do vnitini reprezentace
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7.6 Generator Cilového kodu

Vsechny instrukce implementované v procesoru maji definovano: Jak maji byt vykonané
procesorem, vstupni a vystupni typy a syntax. Tedy vsSe, co generator cilového kédu potre-
buje znat, aby tyto instrukce mohl pouzit. Generator cilového kédu si pri vytvoreni nacte
vSechny instrukce podporované procesorem a prevede je na operace ve vnitini reprezentaci.
Dale zpracuje definici vSech registrovych poli (v tuto chvili procesor obsahuje dvé registrova
pole: Celoé¢iselné a pro ¢isla s plovouci fadovou ¢arkou).

7.6.1 Zakladni fungovani

Generator cilového kédu se zavola na dokonceny program a zacne ho zpracovavat postupné
po jedné instrukci, ve vyjimeéném pripadé po dvou. Kazdé instrukce ve vnitini reprezen-
taci projde vSechny prevedené instrukce z cilové architektury, nez najde takovou, ktera
vykonava stejnou operaci. Nicméné nékteré operace z vnitini reprezentace nejsou defino-
vané v procesoru. V takovém pripadé musi generdtor operaci nahradit pomoci dostupnych
operaci.

Generator cilového kddu se umi vyporadat s témito problémy:

o Instrukce z prekladace nepotiebuje tieti hodnotu a instrukce procesoru bere jako
posledni argument konstantu. V takovém pripadé vlozi do konstanty hodnotu 0.

e Zalohovani a obnoveni registrii se v této ¢asti zatim nefesi, budou zpracovany pozdéji.

o Procesor neobsahuje instrukei pro porovnani hodnot (<,>,== atd.). V takovém pii-
padeé se prozkouma, zda je dalsi instrukce podminény skok a vykonava stejnou operaci.
Pokud se toto nepodari namapovat, zkusi zaménit operandy.

¢ Neexistuje instrukce nacteni konstanty nebo presunuti hodnoty v registru. V takovém
pripadé se pouzije instrukce sec¢teni s konstantou.

Béhem mapovani instrukce se zéroven prevedou vsechny proménné (k nim se pristupuje
pouze pomoci operaci pracujicich s paméti) na adresovdni pomoci zdsobniku. Z tohoto
divodu si musi generator cilového kédu pamatovat adresu proménnych a velikost kazdého
ramce, aby mohl proménnym davat spravnou adresu. Nicméné tato adresa je zatim pouze
docasnd, protoze stile neprobéhlo zalohovani a obnova registrii, ktera bude vyzadovat misto
na zasobniku.

7.6.2 Prepis registri a adres

Po namapovani vsech operaci na cilovy kéd je potfeba namapovat vSechny registry na
cilovou architekturu. Prekladac si rezervuje nékolik registria pro své zakladni potieby:

o Registr x0 je v architekture vzdy rovny 0. Prekladac jej tedy vyuziva, kdyz potiebuje 0.
o Registr x1 je pouzit pro navrat hodnoty z funkce.

o Registr x2 je pouzit jako zasobnik.

o Registr x3 se pouziva jako adresa pro navrat z funkce.

e Vsechny registry navic jsou pouzity jako docCasné registry.
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Funkce prejmenovavani registri vyhleda registr pomoci regularniho vyrazu a nahradi
za nazev pouzity v registrovém poli. V této ¢asti zaroven i probihd zalohovani a obnova
registri. Pokud zpracovavand instrukce predstavuje zalohovani registri, zac¢ne prekladac
zaznamenavat pouzité registry a instrukce do té doby, nez se zaCne zpracovavat obnoveni
registri. V tu chvili se ulozi vSechny registry na zasobnik a obnovi se ze zasobniku. Mezi né
se vlozi vSechny instrukce, které se zpracovaly mezi zalohou a obnovou, a pokud pristupovaly
k proménnym, aktualizuje jejich adresu podle mnozstvi uloZenych registri.

7.7 Grafické rozhrani

Implementace grafického rozhrani o prekladac¢ spocivala v rozsireni zdlozky code. V této
zalozce byl z puvodniho simuldtoru jiz naimplementovan jednoduchy editor na tvorbu pro-
gramu v jazyce symbolickych instrukci. Ten podporuje zvyraznovani napsaného koédu, ote-
virani nékolika soubortu v zdlozkach, kontrolu napsaného kédu a jeho nahrani do instrukéni
paméti procesoru.

Presnéji jsem pro aktualizaci grafického rozhrani o preklada¢ provedl tyto kroky:

1. Prepinani pohledu mezi jazykem C a jazykem symbolickych instrukei.
2. Dalsi zalozku editoru v C pohledu, do které se nahraje prelozeny kod.

3. Zvyraznéni ¢sla fadku barvou podle éisla v editoru. Radky v prelozeném kédu maji
stejnou barvu jako fadek ze kterého byly prelozeny.

4. Kompilace C souboru provede kompilaci pomoci C prekladace a pouzije puvodni kom-
pilaci kédu k nahrani do procesoru.

5. Zvyraznovani syntaxe C kédu.

Snimek obrazovky zalozky kod po upravach obsahuje obrazek 7.9.
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File Simulation Code

int main()

int matrix1[16] =

int matrix2[16] =

int resultMatrix[16];
for (int i =0; i < 4; i=i+1)

Help

k& H&O

EmptyFile.r5 | cMatrixMultiplication.c X

AW X0 XZ 190

{1, 1, 1, 1, add x5 x2 x5
2, 2, 24, 24, sw x4 x5 128
3, 3, 3, 3, 1w x4 x2 200
T addi x5 x@ 1
{1, 2, 3, 4, add x4 x4 x5
i, 2, 3, 4, sw x4 x2 200
1, 2, , 4, jal x@ cycle@condition
1, 2, S cycle@end:

1w x4 x2 196
addi x5 x0 1

{ add x4 x4 x5
for(int j = @; j < 4; j=j+1) sw x4 x2 196
{ clelcondition
for(int k = 0; k < 4; k=k+1)
{ 1w x4 x2 192
resultMatrix[i*4+j] = resultMatrix[i*4+j] + matrix1[i*4+k] * matrix2[k*4+j]; addi x5 x@ 1
} add x4 x4 x5
} sw x4 x2 192
} jal x@ cycleZcondition
} cycle2end:
Console

Code compiled with no errors!
Loaded to simulation...

Obrézek 7.9: Zalozka code po implementaci prekladace
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Kapitola 8

Implementace mezi-paméti

Jak jiz bylo popsdno v kapitole 6, dalsi rozsireni simuldtoru spoc¢iva v implementaci mezi-
paméti a zobrazeni paméti. Oproti prekladaci byla implementace mezi-paméti samotné
pomérné jednoducha. Slozité bylo napojeni mezi-paméti do puvodniho kédu simulatoru.
Implementace mezi-paméti probihala nasledovné:

1. Implementace bloku mezi-paméti.

2. Implementace ndhodné politiky vybéru.

3. Implementace kontrolni logiky mezi-paméti.
4. Napojeni do procesoru.

5. Grafické rozhrani.

Rizeni simulace.

Implementace zpozdéni.

© N o

Implementace zpétné simulace.
9. LRU a FIFO politiky vymény.

10. Nastavitelnost mezi-paméti.

8.1 Implementace bloku mezi-paméti

Blok mezi-paméti predstavuje zakladni prvek udrzujici informace o stavu mezi-paméti. Blok
je implementovany jako pole Integer hodnot, Boolean hodnot pro bity Dirty a Valid, Long
hodnota pro Tag. Déale si udrzuje zacinajici adresu ulozenych dat a nékolik pomocnych
proménnych pro grafické rozhrani a historie pro zpétnou simulaci.

Hlavni funkce implementované blokem, mimo funkci nastavujici nebo ziskavajici hodnoty
vyse zminéné, jsou:

o getData: Nacte data z bloku podle zadané adresy a velikosti - zarovnany pfistup.

o setData: Nastavi data do bloku podle zadané adresy a velikosti - zarovnany pristup.

Tyto funkce pristupuji k jednotlivym prvkum tak, ze z dané adresy ur¢i index bloku drzici
data a vymaskuji z ni hodnotu o dané velikosti.
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8.2 Implementace kontrolni logiky mezi-paméti

Kontrolni logika mezi-paméti je zodpovédnd za komunikaci s paméti a pristupu k blokim.
Pri vytvoreni si mezi-pamét vytvori dvourozmérné pole bloki, kde prvni rozmér je urcen
indexem a v druhém jsou bloky se stejnou asociativitou. Déle si mezi-paméf udrzuje in-
formace o jejim nastaveni: Asociativitu, pocet blokt, velikost blokti, implementaci politiky
vymeény, nastaveni chovani pfi zapisu.

8.2.1 Implementace pristupu do mezi-paméti

jiz podporuji nezarovnany piistup i pres dva bloky:

Rozdel adresu na Tag, Index a Offset
For (Blok na indexu):
If (Tag bloku == Tag z adresy):
Proved pristup
Return
//Blok s danou adresou neni v mezi-pameti
Vyber obetni blok
If (Obet obsahuje pozmenena data): //ma nastaveny dirty bit
Uloz obetni blok do pameti
Nacti cilovoy blok z pameti: Valid 1, Dirty O
Proved pristup

Vypis 8.1: Pseudokdd pristupu do mezi-paméti

If (Zpracovava se ulozeni dat AND je nastaveno propisovani do pameti):
Nastav bloku priznak, ze ma pozmenena data //Dirty bit

If (Pristup je zarovnany):
Proved pristup do bloku
ElseIf (Pristup je nezarovnany, ale v jednom bloku):
Proved pristup do bloku po Bytu
Else:
Proved pristup do bloku po Bytu dokud se pristupuje do stejneho bloku
Rekurzivne zpracuj zbytek pozadavku

Vypis 8.2: Pseudokdd provedeni pristupu do bloku

8.3 Napojeni do procesoru

Napojeni do procesoru jsem planoval provést stejné, jako byl pristup do paméti. Nicméné
béhem napojovani se projevil jeden zasadni problém. Simulator nezpracovaval ukladani
dat v jednotce pro pristup do paméti (MAU) a misto toho provedl pristup do paméti
béhem dokonceni instrukce v sefazovaci paméti. Simulator mél sice spravné vysledky, ale
tento pristup neodpovidé realité, protoze realny procesor uvedeny pristup samoziejmé musi
vykonat. Tudiz jsem musel upravit kéd, aby se ukladani dat zpracovavalo pres MAU, coz
s sebou prineslo nékolik problémi. Mimo zavedeni novych chyb, které bylo potieba opravit,
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se jednalo treba o upravu velké Géasti test simulace, protoze se opravou zménilo chovani
procesoru.

V tuto chvili jiz bylo mozné pripojit mezi-pamét na stejném misté jako byla pfipojena
pamét, ale bylo potreba upravit pristup k datim. K puvodni paméti simulator pristupoval
po Bytu, coz s mezi-paméti neslo. Kvili lepsi praci s kontrolni logikou a vypocétu zpozdéni
se pristup k mezi-paméti provadi cely najednou.

8.4 Grafické rozhrani

Pro préci s grafickym rozhranim bylo potifeba rozsitit mezi-pamét o zapamatovani posled-
niho provedeného pristupu, ktery obsahuje tyto informace:

e Tag, index a offset.

o Zda dany blok (nebo bloky) byl na¢teny v mezi-paméti.
o Poradi pristoupeného bloku v mezi-paméti.

e Typ pristupu.

o Data (pokud se jedna o ulozeni dat).

Grafické rozhrani jsem vytvarel se stejnou myslenkou, kterou jsem uplatnil pfi navrhu
v kapitole 6, zobrazeni vyrovnavacich paméti pro ukladani a nac¢itani dat, zobrazenou mezi-
pamét a posledni pristup do ni. Nicméné béhem vytvareni se ukazalo zbyvajici misto po
strané zalozky mezi-paméti. Z toho duvodu jsem presunul zobrazeni paméti, které podle
planu mélo byt v tabulce pod mezi-paméti, do seznamu na pravou stranu obrazovky.

Po kazdém pristupu do pameéti se aktualizuje zobrazeni mezi-paméti i paméti. Pro mezi-
pamét se navic ukaze, ke které bunce mezi-pameéti se pristupovalo naposledy. Zda jiz data
v mezi-paméti byla (Hit) nebo ne (Miss) lze poznat podle barvy.

Vysledné grafické rozhrani pro mezi-pamét je na snimku obrazovky na obrazku 8.1

Do okna simuldtoru navic pribyla zdlozka poslednich pristupu do paméti na misté regis-
trovych poli. Podle planu méla byt tato tabulka umisténa pfimo v okné simulace, ale toto
umisténi 1épe vyuzilo prostor na obrazovce.

8.5 Uprava rizeni simulace

Béhem zkouSeni simulace v zalozce mezi-paméti se projevilo, Ze je potieba upravit rizeni
simulace. Krokovani po jednom cyklu ¢asto zptsobovalo, Ze bylo potfeba odklikat nékolik
kroki, nez nastal dalsi pristup do pameéti, kvili ¢emuz se s programem Spatné pracovalo.
Tudiz jsem upravil fizeni simulace, aby krokovalo po pristupech do paméti. Krokovani
v pohledu na mezi-pamét tedy spusti simulaci a v momenté, kdy zaznamena pristup do
paméti, pozastavi vykonavani programu.

Podobnym zptusobem bylo také potfeba upravit krokovani v pravidelnych intervalech.
V zakladnim pohledu simulace se krokovani provadélo uvniti simuldtoru a pouze se in-
formovalo grafické rozhrani, aby znovu vykreslilo stav procesoru. Nicméné pro pravidelné
krokovani po pristupech do paméti jsem se rozhodl vyuzit jiz naimplementované krokovani
z predchoziho kroku. Kazdych X milisekund (interval zada uzivatel) se spusti zpracovani
dalsiho kroku.
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Fle Simulation Code Help

@
P oww e O 4 M W g
Ind Cod Dat: L
R —_ store buffer Lozd buffer Address a :
oo 001 S
x66  addix6x04 code Address  Data Code Address  Data  Bypass =
2 s 0x1
067 mul X5 x5 %6 Sw t17 %296 60 RFADY w122 32 192 FAEAAE. WAIT  NO 2
o8 0x1 4
x68  add 5525 swt13x2100 FAFATE... READY IWt25 52196 AT, AT NO 2
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P w142 104 ... READY s = ST ata w128 12 200 . WAT  No o . g
0x6a w15 x2108 FAFFRE.. READY | | |uope oo o3 |mo |ox0 w3032 192 S AT NO e . £
0x6b  addix7x04 swt16x2112 THTAATA.. READY Iwt33 32 196 A AT NO s - 2
x1 x
Cx6e  mul 66 K7 s 17x2116 ... READY w138 (37128 (. WAT  NO
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000 )
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Ox6l addiz7x04 sw20x2128 L. READY w47 w60 M. AT NO
28 03
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2 (2= 04
072 6664
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074 add x4 x4 x5 Index| Valid Dirty Tag Block7 Blocks Blocks Blocka Blocks Block2 Block1 Blocko
0ac 04
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oxas 02
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[ 01
x7a addiz6 04 02 0 0 00 00 00 00 0x0 00 0:0 00
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e 0xa
O7d swxdxs 128 o4 0 0 00 00 00 00 0x0 00 00 00
060 0x1
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Obrazek 8.1: Grafické zobrazeni mezi-paméti

8.6 Implementace zpozdéni

V redlném procesoru mezi-pamét znacné urychluje vykonavani programu, nicméné pro ma-
ximalizaci vykonu je potfeba vyuzivat mezi-pamét co nejlépe, jinak mize mezi-pamét i
uskodit. Stejnou funkcionalitu bylo nutné i pfidat do simuldtoru. Proto jsem rozsitril mezi-
pamét o schopnost vypoctu zpozdéni daného pristupu.

Zpozdéni ma statickou slozku, kterd je nastavitelnd pro nacitani i ukladani dat, a dy-
namickou slozku, coz je zpozdéni zpiisobené vyménou bloku. Do kazdého nacitani dat se
tedy prida i ¢as pro vyménu bloku v ptipadé, Ze blok neni obsazeny v mezi-paméti. Navic je
mozné nastavit, zda se mé zpozdéni zapocitat do ukladani dat. V pripadé ze tato moznost
neni nastavend, je potieba do nacitani dat také zapocitat zbyvajici ¢as pro nacteni bloku
z pameéti po predchozim ukladani dat. Jeden pristup do paméti tedy mize mit zapocitané
zpozdéni i nékolika vymén bloku, které s timto blokem nesouvisely, protoze bylo potreba
obslouzit je diive.

Samotné vykonani zpozdéni se fesi v jednotce pro pristup do paméti, kterd jiz méla
naimplementované zpozdéni. Nicméné to bylo nutné upravit. MAU nejdiive vykona své
zpozdéni. Poté provede pristup do mezi-paméti, ze které ziskd zpozdéni daného pristupu, a
poté toto zpozdéni vykona.

8.7 Implementace politik vymény
Cilem implementace politiky vymeény bylo jednotné pouziti mezi-paméti nezavislé na vy-
brané politice. Z toho duvodu pracuje se zakladni tiidou, ktera definuje pouze prototypy

funkei. Politika vymény si urci, jakou informaci potiebuje. Naptiklad ndhodna politika
vymeény nepotfebuje zadné informace.
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Vsechny politiky vymény proto implementuji tyto funkce:
o Aktualizuj politiku: Zavola se s kazdym piistupem do bloku.
o Ziskej blok k vyméné: Zavold se vzdy, kdyz je potfeba vyménit blok.

e Obnov historii: Pouziva se pro zpétnou simulaci.

8.8 Nastavitelnost mezi-pameéti

Poslednim krokem bylo umozZnit nastavovani konfigurace mezi-paméti. Z toho divodu pfi-
byla v nastaveni zélozka pro mezi-pamét (obrazek 8.2 ukazuje zakladni nastaveni).

Loader | Buffers | Function Unit | Branching | Fetch and Commit | Cache

Cache - Number of lines - Magnitude of 2 16
Cache - Associativity: Magnitude of 2 2

Cache - Line size : in Bytes, Magnitude of

4 32

Cache - Replacement policy Least Recently Used -

Cache store behaviour Write Back -

Should remaining line replacement delay
be added to store?

Cache - store delay 0
Cache - load delay
Cache - line replacement delay 10

Confirm Cancel

Obrazek 8.2: Nastaveni mezi-paméti

Celkové mezi-pamét umoznuje tyto nastaveni:
e Pocet blokii.

e Asociativita.

e Velikost bloku.

o Politika vymeény.

e Chovani pii zapisu.

o Priddni ¢asu vymény bloku k ulozeni dat.

o Zpozdéni ukladani dat.

e Zpozdéni nacteni dat.

e Doba vymény bloku.

57



Kapitola 9

Implementace statistik

Rozsiteni statistik spocivalo v pridani sbéru informaci, jakym zpisobem program pracuje
s mezi-paméti. Podobné jako u implementace mezi-paméti se projevilo, Ze na realné obra-
zovce je nutné pocitat s jinym rozvrzenim prostoru, nez pii tvorbé navrhi. Zakladni napad,
jak byl popsan v kapitole 6, zustal stejny. Pouze rozvrzeni obrazovky vypada rozdilné.
Vysledny vzhled zalozky statistik se nachézi na obrazku 9.1 a obsahuje dva grafy s informa-
cemi o prubéhu programu. Navic obsahuje liSty se statistikami, které se zobrazuji i v zalozce
simulace respektive v zalozce mezi-paméti.
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Total daay: at02 ‘
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Obrazek 9.1: Vzhled zalozky statistik

Noveé se sbiraji tyto statistiky z mezi-paméti:

o Pocet pristupt.

o Pocet uspésnych pristupi do mezi-paméti.

o Pocet netspésnych pristupt do mezi-paméti.

e Prumérné zpozdéni zptsobené pristupem do mezi-paméti.
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e Celkové zpozdéni zplisobené piistupem do mezi-paméti.
e Graf zpozdéni zplisobené pristupem vykresleny v case.
o Graf poslednich ¢tyr pristupu vykresleny v cCase.

Nejuzitecénéjsi ze statistik podle mého nazoru budou grafy, kde je mozné vysledovat,
jakym zpusobem program pracuje s paméti. V idedlnim pripadé by graf poslednich ¢tyr
pristupi (spodni graf na obrazku 9.1) mél ukazovat stabilni stav pfistupti k dattim, které
se jiz v mezi-paméti nachazeji, nebo obcasny pokles z divodu vymény bloku. Podobné
by mél vypadat i graf zpozdéni (vrchni graf na obrazku 9.1), nicméné tam navic mize byt
ukézano, v jaké ¢asti programu probihd vice operaci nac¢itani/ukladéni dat (za predpokladu,
ze maji viditelné rozdilné zpozdéni).
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Kapitola 10

Zhodnoceni implementace

Cilem prace bylo rozsirit simulator superskalarnich procesori, aby bylo mozné jednoduseji
vysveétlit principy fungovani procesoru, jakym zptsobem vykonava programy, které progra-
mator napise.

10.1 Ukazkové priklady

K tomu icelu jsem zaroven vytvoril ukazkové priklady ukazujici nékteré zakladni principy.
Jsou to dva programy, které vykonavaji nasobeni matic. V prvnim piikladé se nasobi matice
4x4 a v druhém matice 5x5, aby bylo mozné jednoduseji ukazat uzitecnost zarovnavani dat.
Dale se jedna o program implementujici vypocet Fibonnaciho posloupnosti pomoci rekurze.
Posledni ukazkovy priklad implementuje bublinové fazeni pole (bubble sort). Rychlost to-
hoto Tazeni vyrazné ovliviiuje, zda se celé pole vejde do mezi-paméti, coz z néj tvori idedlni
ukazkovy priklad. Béhem téchto programu zaroven vznika fada situaci v procesoru, jako
jsou povedené a nepovedené predikce skoku, predbihani ukladani dat nac¢itanim dat, vyko-
nani velkého mnozstvi operaci pii dlouhém ¢ekdni na data (zévislé na nastaveni zpozdéni
z mezi-paméti) apod.

10.2 Zhodnoceni prekladace

Vytvareni prikladu v jazyce symbolickych instrukeci je sice mozné, nicméné jedna se o zdlou-
havy proces nachylnéjsi k chybam, a slozitéjsi pro studenty na pochopeni, co dany algo-
ritmus déla. Pridani prekladace by mélo zjednodusit tvorbu priklad a pomoci studentim
pochopit dany koéd. Dle mého nazoru se jako velmi uziteéné projevi zabarvovani radku v ci-
lovém programu jako ve zdrojovém kédu, jelikoz pro mé samotného to bylo ndpomocné
béhem opravovani chyb, které se béhem zkouseni ukizkovych piiklada objevily.

Protoze prekladac¢ neoptimalizuje svij kéd, vykonava rfadu zbyteénych piistupt do pa-
méti, coz vyrazné prodluzuje délku programu. Je sice mozné, ze se to projevi jako uzitecné
(napf. by to studentiim mohlo pomoci pochopit, co vSe preklada¢ déld, aby urychlil vyko-
navani programu), ale pro fadu véci to muze byt limitujici.

10.3 Zhodnoceni mezi-paméti

V ramci predmétu AVS se Casto vyuziva nasobeni matic a zkouméni jakym zptusobem je
mozné optimalizovat kéd, aby dobfe pracoval s mezi-paméti. V tomto predmétu se sice
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implementuji programy, které zpracovavaji mnohem vétsi data, nez by bylo mozné odsi-
mulovat v simulatoru. Ocekavam, ze v ramci simulatoru se budou spoustét mnohem mensi
programy, nez jsou realné aplikace, protoze danou problematiku je mozné vysvétlit i na
mnohem jednodussich ptikladech.

Jako uzite¢né by se mohlo projevit krokovani po operacich pfistupujicich do paméti,
kde je jasnéji viditelné jakym zpluisobem program pracuje s paméti, ale i v tomto ohledu
mize chybéjici optimalizace v prekladaci trochu kazit tuto funkcionalitu. Dale muze byt
mirné limitujici omezeni pouze jedné jednotky pro ptistup do paméti (MAU) s mezi-paméti.
Presnéji feceno mezi-pamét funguje i s vice MAU, nicméné zpozdéni zpusobené vymeénou
bloku muze zpusobit nezddouci chovani (vétsi zpozdéni, nez by se dalo ¢ekat). Tento problém
se da obejit nastavenim doby vymény bloku na 0. V takovém pripadé sice neni ziejma
vyhoda mezi-paméti, ale stale je mozné ukazat vyhodu vice MAU.

10.4 Zhodnoceni statistik

Myslim, Ze nové okno se statistikami neni oproti prekladaci a mezi-paméti sice tak dulezité,
ale i tak miize byt uzitecné k ndzorné ukazce jak neoptimalni prace s paméti muze negativné
ovlivnit chovani programu. Jak jsem se jiz zminil v kapitole 9, nejspise nejuzitecnéjsi budou
grafy pro vizualizaci prubéhu programu. V soucasnosti jsou v tomto okné pouze dva grafy,
ale v budoucnu by jich mohlo byt vice, protoze implementace prekladace umozni vytvaret

vvvvv

ochotny vytvorit).

10.5 Dalsi mozna vylepseni

Studenti vyuzivajici tento simulator by mohli tézit z dalsich rozsifeni. Mezi dalsimi moznymi
rozsifenimi simuldtoru by mohla byt napiiklad:

e Optimalizace v prekladaci.

e Implementace vlaken.

e Doplnéni mezi-paméti o presnéjsi praci s vice MAU.
o Ukladani konfigurace.

e Pridani adresy k instrukcim.

o Oddalovani/ptiblizovani okna simulace.

e (Oddéleni zalozky do samostatného okna.
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Kapitola 11
Zaveér

V ramci této prace jsem popsal zdkladni jednotky, které se v procesoru nachéazeji a jakym
zpusobem funguje superskalarni procesor vykonavajici instrukce mimo programové poradi.
BliZe jsem se zaméril na fungovani mezi-paméti, jelikoz implementace pamétového subsys-
tému byla dilezitou soucasti mé prace. Déale jsem popsal k ¢emu slouzi prekladace a jak
funguje implementace prekladace Fizeného syntaktickou analyzou.

V posledni ¢asti, nez jsem se pustil do navrhu rozsifeni simuldtoru, jsem prozkoumal
dalsi existujici simuldtory procesorii a mezi-paméti. Béhem tohoto procesu jsem objevil si-
mulator, o kterém si myslim, ze by mohl byt uzitecny ve vysvétlovani fungovani procesoru,
nicméneé i tento simulator mél své nevyhody. Hlavni nevyhodou byla chybéjici implementace
se slozitost{ procesoru, ale na druhou stranu v ném chybély uzitecné Casti, které v jinych
simuldtorech jiz existovaly, nicméné nékteré z téchto chybéjicich prvka jsem dale implemen-
toval.

Soucasti mych rozsifeni byla implementace prekladace ze zjednoduseného jazyka C,
mezi-pamét a rozsireni statistik o data z mezi-paméti. VSeobecné mnou implementovana
rozsifeni vypadala jinak nez podle ndvrhu, nicméné zmény vedly k lepsimu vyuziti prostoru
a prijemnéjsi praci se simuldtorem.

vvvvv

vvvvv

vyzadovalo dostatecné dlouhy program. Navic zobrazeni vSech operaci, které musi procesor
vykonat pro zpracovani programu, muze studentlim pomoci 1épe pochopit chovani jejich
kédu.

Implementace mezi-paméti prinasi dalsi benefit této prace pro studenty. V ramci pred-
métu AVS se snazi studenti co nejefektivnéji vyuzit procesor, aby dosahli co nejrychlejsiho
vykonani jejich programu, ktery ¢asto souvisi se zpracovianim dat (napf. ndsobenim ma-
tic). Uvedené zasadné souvisi se zptuisobem, jakym jejich program pracuje s mezi-paméti.
Simulator sice nebude schopny zpracovat tak velké programy, nicméné stejné principy lze
vysveétlit i na mnohem mensich piikladech. Domnivam se, ze k vysvétleni zptisobu fungovani
mezi-paméti se obzvlast bude hodit krokovani po operacich pristupujicich do paméti.

Poslednim rozsifenim simuldtoru implementovanym v této praci bylo sbirani statistik
z mezi-paméti. Dle mého nazoru nejuziteénéjsi bude zobrazeni grafu, jelikoz na prilis dlou-
hém programu, jiz nebude mozné sledovat program pomoci krokovani. Z duvodu zpozdéni
pristupu do paméti a velkého mnozstvi pristupt do paméti se program muze vykonavat i
nékolik tisict cyklu.
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Béhem pouzivani programu vyucujici nebo studenti moznéa objevi dalsi rozsifeni, kterd
by pro né byla uziteéna a kterd by uvitali v tomto programu (o nékterych jsem se jiz zminil).
Doufam, ze nékdo dalsi prevezme Stafetu a rozhodne se rozsiFit tento simuldtor o dalsi prvky

a zpifjemni Zivot nové fadé studentu.
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Priloha A

Obsah prilozeného disku

DVD disk obsahuje tyto soubory a slozky:

e ./Source - Obsahuje zdrojové soubory aplikace s Readme.md souborem obsahujici
navod jak je sestavit.

e ./Thesis - Slozka obsahuje IXTEXzdrojové soubory pouzité k vygenerovani tohoto
dokumentu a tento dokument.

o ./Application ! - Aplikace samotn4 s Readme.md souborem obsahujicim névod ke
spusténi.

!Soucasns verze aplikace je také dostupnd na https://nextcloud.fit.vutbr.cz/s/JcAkwNxS8etioQbX
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Priloha B

User manual

This chapter explains how to install, use, and configure the RISC-V simulator.

Installing dependencies

Linux

You need to have JDK 15 or higher installed on your system. If you don’t have JDK 15
installed, follow the steps below:

Ubuntu

You will need at least openjdk-15-jre and openjdk-15-jdk packages. To install then use
the following commands:

sudo apt-get install openjdk-15-jre
sudo apt-get install openjdk-15-jdk

Usually, after installing these packages they should be set as default. To check the set
version, use:

java --version
If not, use update-alternatives to change the default version of java.

sudo update-alternatives --config java

Arch Linux/Manjaro
To install required packages, use the following command:

sudo pacman -S jrelb-openjdk-headless jrelb-openjdk
sudo pacman -S jdkl5-openjdk openjdkl5-doc openjdklb-src

After that, you need to set the default JDK using the following command:
sudo archlinux-java set java-15-openjdk

To check which version is active you can use archlinux-java statusor java --version.
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All versions

After installing the required packages, you need to run the run.sh script. Most of the time,
you will need to set up permission to be able to run this script. Use chmod +x run.sh to
make it runnable. After that, you’ll be able to run the application.

Windows

Download and install the Java SE Development Kit 16.0.1 from the official Oracle site:
https://www.oracle.com/java/technologies/javase-jdkl6-downloads.html and after
that, run the ‘run.bat‘ file.

Application window

The simulator consists of four main windows that are linked to the control tabs on the
right side of the screen, being the Simulation, Cache, Statistics and Code windows. The
Simulation window can be seen at the start of the application. It is used for controlling and
the visualization of the simulation. The Cache window visualises the state of cache and is
used to control simulation per Load/Store access. The statistics windows shows statistics
gathered throughout the simulation. The Code window serves as an input for user-made
source code, written in subset of C or following the ISA loaded by the application. There
is also the main menu on the top of the screen where users can configure the simulator
properties, load existing examples, and find out which instructions got loaded.

| File Simulation Code Help The main menu
I I > 1000 ms | Period 0 K " » The window selection tabs é‘
c
Index Code Integer physical register | Floating point physical register | Last Memory Accesses E"’,
0x0 nop A Register name Value Register name Value Register name Value Register name Value Register name Value Register nai Value Register name i
01 |nop x0 0 X5 0 x10 0 x15 0 x20 0 x25 0 % 2
0x2  nop x1 0 X6 0 x11 0 x16 0 x21 0 x26 0 x31 %
0x3  nop x2 0 x7 0 x12 0 x17 0 x22 0 x27 0 I
Ox4 nop x3 0 x8 0 x13 0 x18 0 x23 0 x28 0 %
05 nop x4 0 9 0 x14 0 x19 0 x24 0 x29 0 v
0x6  nop | %
L0

0x7  nop | I

Obrazek B.1: The main application controls

Code window

The Code window is used for entering source code and loading it into the simulation logic.
For entering the source code, please use the Code text area in the middle. The code window
menu is located at the top of the window, providing controls for file manipulation and
compiling the source code. At the bottom, there is a console output, for the result of the
compilation, which on success, loads the code into the simulation. The code windows default
view contains window for compiled C-code, but that window can be hidden by clicking on
the change view button. When the C-program is compiled, the lines’ color in the compiled
code match the lines’s color from which it was generated.
The window button functions are from the left as follows:

e New - Opens a new sheet for the source code
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= EH & O

New Open Save Compile Switch
sheet file fle code view

Obrazek B.2: The Code control buttons

Open - Opens a file dialogue to selected the file to be loaded into the code window. If
the selected sheet is empty, it will load into the selected one. Otherwise, a new sheet
with file contents will be opened.

Save as/Save - The selected sheet will be saved. If not saved before, a file dialogue
opens, expecting the user to specify the path and filename. If the sheet has been saved
before, changes will be saved into that file.

Compile - Takes the selected sheet and tries to compile it and load it into the si-
mulation. If an error arises, the output is written into the Console window. The file
will be compiled as C program if the file ends with .c extension. Otherwise assembly
loader will be used.

Change view - Switches between C and assembly view (shows/hides compiled assembly
code)

The Code window sheets support basic highlighting.
Highlighting for C-code is as follows:

Green - Represents keywords.

Red - Represents the registers loaded into the simulator.

Blue - Represents data type.

Orange - Represents variable name, function name or constant

Black - Represents operation or bracket

Highlighting for assembly code is as follows:

Green - Represents the instructions loaded into the simulator.
Red - Represents the registers loaded into the simulator.
Blue - Represents numerical values.

Orange - Represents labels. List of acceptable labels if formed dynamically based on
the source code

Grey - Represents comments

The list of allowed instructions and their syntax can be found inside the Help->Instruction
list in the main menu.
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File Simulation Code Help

E E 'u' o The code window menu

addi x4 x0 0

sw x4 x@ @ Compiled
functionmain: assembly
addi x4 x0 6 code

sw x4 x2 @

EmptyFile.rs | cMatrixMultiplication.c | cFibonacci.c X Source code sheets

int result;

int fib(int n)

{

sw x2 x2 4

. s
if (n : 1].. addi x2 x2 8

re ﬁrn n; i ) jal x3 functionfib
return fib(n - 1) + fib(n - 2);

add x4 x0 x1
! sw x4 x@ 0
. i functionmainend
int main()
1 {
result = fib(e);
}

jal x@ programend
functionfib:
sw x4 x2 @
sw x5 x2 4
sw x3 x2 12
sw xb x2 16
1w x4 x2 -8
addi x5 x0 1
blt x5 x4 if@else
@ 1w x1 x2 -8
1 jal x@ functionfibend
iflelse:
1w x4 x2 -8
addi x5 x0 1
sub x4 x4 x5
sw x4 x2 20
sw x2 x2 24
addi x2 x2 28
jal x3 functionfib
add x4 x0 x1

sonsnels | apo) | ayoes | uonenuis

Console

The console text area

Code compiled with no errors!
Loaded to simulation...

Obrazek B.3: The Code window

Operations supported by the compiler

The compiler supports subset of C language. Support for some operations depends on their
support by processor. That is especially true for comparison and logical operations. Because
by default the processor doesn’t implement them. So comparison operatos can be used by
default only as the last operation in the condition (e.g. 4 < 5+3).

These features are implemented by the compiler:

e Data types: Integer and Float

e Control statements: For, While, If

o Functions: Must be defined before use; Allows recursion; Can use void as return type.
e Main: Must be defined, doesn’t allow input arguments

o Conversion between data types

e Curly brackets allowed only in control statements and function definitions
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¢ Global variables

e 1D arrays

Simulation window

In the simulation window, users can simulate their code after a successful compilation. If
the user is inside the Code window during the compilation, a dialogue will ask him, if they
want to move to this window. Inside the window, the user can find:

LR PR [FR 3
Frorke i p

The simulation control buttons

L
g

The |7
compiled |
code

TR T The register file view
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Obrazek B.4: The Simulation window

¢ Control menu - Placed on the very top of the window, with controls to the simulation
o Register file window - Situated on the top of the screen, displaying all loaded registers.
e Code window - Situated on the right, showing the compiled code.

e Simulation view - Showing all the blocks of the simulation

o Statistics - At the bottom, showing the gathered statistics from the run

The control menu button functions are from the left as follows:
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o Pause - Stops the periodic execution.

e Play - Steps the simulation at fixed intervals. The period can be changed in the Period
text field located also in the menu

o Reset - Resets the simulation to the initial state

e Previous step - Simulator will take one step back in the simulation. If the simulation
is in the initial state, nothing happens.

e Next step - Simulator will take one step forward in the simulation.

¢ Fast-Forward - Simulator will simulate the whole input source code and shows the
result. (WARNING: may take some time)

II > 1000ms  Period ¥ ) H H »

Pause the Play the Play simulation Resetthe Previous Next  Fast-
simulation simulation period simulation step  step forward

Obrazek B.5: The Simulation control buttons

As soon as the simulation reaches the end, the user is notified using the dialogue window.

Cache window

The cache window is used for displaying cache and memory contents and accesses to cache
from the core. In the middle-top of the window it displays last executed access with contents
of Load/Store buffer. In the middle-bottom there is table displaying cache contents with last
access highilghted (green/red for hit/miss). On the right there is a list displaying contents of
memory in 4 Byte words. On the bottom of the window is a list of cache statistics gathered
during simulation.

The cache changes behaviour of simulation control, specifically the step size. In cache
window the steping is done per memory access. If multiple accesses occur in the same cycle,
the simulation stops after the access from last MAU.

The buttons on simulation control panel in cache window (shown in picture B.5) are:

o Pause - Stops the periodic execution.

e Play - Steps the simulation at fixed intervals. The period can be changed in the Period
text field located also in the menu. Step is a memory access.

o Reset - Resets the simulation to the initial state

e Previous step - Simulator will take one step back in the simulation. If the simulation
is in the initial state, nothing happens. Step is a memory access.

o Next step - Simulator will take one step forward in the simulation. Step is a memory
access.

¢ Fast-Forward - Simulator will simulate the whole input source code and shows the
result. (WARNING: may take some time)
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File Simulation Code Help

— @
Il B ooms beics ) |4 P| PP Thesimulation control panel 3
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indexCode = T Wemory content Adress CEr R H
0x0  functionmain 00 oxt 3
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o1 addixax01 oxs oxt 2
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Obrézek B.6: Cache window described

Statistics window

The statistics windows is used to display statistics gathered during simulation. On the
bottom are the same statistics as are shown in simulation and cache windows. On top there
are two graphs displaying cache accesses through the execution of the program.

The top graph shows delay of Load/Store acceses. The bottom graph show average of
last 8 accesses:

e Positive for more hits.

e Negative for more misses.

Basic configuration

The configuration inside the simulator can be accessed by locating the Simulation->Confi-
guration in the main menu. A dialogue will pop out showing multiple tabs featuring different
configuration options.

e Loader - Configuration of the locations of the register file and ISA folders
o Buffers - Configuration for buffer sizes

e Function Unit - Configuration of function units for different issue windows
e Branching - Configuration of the branch units

o Fetch and Commit - Configuration of the amount of instruction fetched /committed
in one cycle

e Cache - Configuration of the cache sizes, access delays and other cache behaviour
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Obrazek B.7: Statistics window described

The function unit configuration tab offers additional configuration options. The users
can create their own function unit or edit the existing ones here. The function unit con-
figuration tab contains additional tabs for each issue window plus the load buffer. Each
sub-tab has a table, showing all the existing function units and at the bottom options for
modifying the table. The options are:

e Add - A pop-up window will show up, with a form for creating a new function unit.
The field delay is required.

e Edit - A pop-up window will show up, with a filled form from the selected function
unit.

¢« Remove - Removes all selected field in the table

Each of the pop-up windows has a Confirm button and a Cancel button. The Confirm
button either adds new correctly configured unit into the list or edits selected function unit
with new values. The Cancel button closes the window without committing the changes.
The ALU and Floating-Point function units have one extra field in the creation pop-up
window, where operators can be specified. The list of allowed binary operators is as follows:

o Add (+)

« Subtract (-)
o Multiply (*)
« Divide (/)
e Modulo (+)
« AND (&)
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« OR (])

o Arithmetic shift right (»>)
o Logical shift right (»)

o Logical shift left («)

o Less than or equal (<=)

o Greater than or equal (>=)
o Equal (==)

o Less than (<)

o Greater than (>)
List of allowed unary operators is as follows:

o Increment (++)
o Decrement (-)
« NOT (!)

o Squared (#)

o Assign (<-)

The comparator operators are used only for the ALU function unit, while they return 1
if the condition is true or 0 if it is false. The assign operator is mainly used for the convert
functions between integer and floating-point values.

When the user wants to confirm his changes, there is a confirm button inside the configu-
ration window, which will reflect the changes and reset the simulation. If the user wants to
exit without confirming the changes, there is a cancel button at the bottom of the window.

Advanced configurations

Apart from the configurations done inside the simulation, users can extend, modify, or
change completely the register files and instructions used inside the application. The default
configuration files can be found in ./riscisa and ./registers folder. These folders are
free to be configured or copied to create different configurations. The configuration files are
written in JSON with a fixed structure of the object names, which every file in a certain
category must follow.

Register file

The JSON of the register file structure can be seen in listing B.1. Each register file object
must have the name, dataType, and registerList. The name specifies the display name that
is used in the Register file window. The dataType is used for comparing with the instruction
argument data types during the compilation. The data type can be either integer (kInt),
long integer (kLong), float (kFloat), or double (kDouble).
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"name": "Integer physical register",

"dataType": "kInt",

"registerList": [
{"name": "x0", "isConstant": true,"value": 0},
{"name": "x1", "isConstant": false,"value": 0},
{"name": "x2", "isConstant": false,"value": 0},

]
}

Vypis B.1: Register file example

The register list must be composed of one or more register objects. The Register object
can be seen in listing B.2. It has 3 objects, a name, an isConstant flag, and a value. The
name is used to address the specified register in the source code, and the user can also see
it in the Register file window. The flag isConstant is telling the simulator, whether the
register value is read-only (flag set to true) or read/write (flag set to true). In the value,
the user can specify the initial value for a certain register.

{
"name": "x1",
"isConstant": false,
"value": O
}
Vypis B.2: Single register example
Instruction

The instruction is also a JSON object. The structure can be seen in listing B.3.

{
"name": "add",
"instructionType": "kArithmetic",
"inputDataType": "kInt",
"outputDataType": "kInt",
"instructionSyntax": "add rd rsl rs2",
"interpretableAs": '"rd=rsl+rs2;"

Vypis B.3: Instruction example

The name is used to address certain instructions when writing the source code. The
instructionType is to specify the type of the instruction. The simulator uses three types,
being arithmetic (kArithmetic), load

The inputDataType is specifying the data type of input arguments. It is used to validate
the data type of an argument if it is the register or used to cast the argument if it is an
immediate value. The outputDataType is used to specify the data type of the output register
argument.

The instructionSyntax is telling the parser the syntax of the instruction with the
types of each argument. The arguments are either destination register (rd), source register
(rsX, where X is a natural number), or an immediate value (immX, where X is a natural
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number). Lastly, the interpretableAs is used to tell the interpreter how arguments should
be processed.

The interpretableAs field has different syntax depending on the type of instruction.
FExamples can be found in the ./riscisa folder. The syntax uses the abbreviations used
by the instructionSyntax to link arguments together. The syntax can be divided into the
3 categories.

Arithmetic expressions that are similar to the Java expression (rd = rsl — rs2 + +,
Increments the value inside the rs2). The arithmetic expressions allows brackets (rd =
(rsl — rs2) * rs3), and also indexing separate bits (rd[5 : 0] = rs1[31 : 25]), where the
range needs to be specified in the "downto'fashion. See the FX and FP instructions in
Help->Instruction list for more examples.

Branch instruction syntax has two versions: unconditional jump (by specifying jump in
the interpretableAs field), or conditional jump, where the syntax is as follows:
"(unsigned|signed) : compareEzpression'. The first part of the conditional jump syntax
tells the interpreter, whether the expression should be evaluated as signed or unsigned.
The second part is the condition, where compare operators and either the register, the
immediate value, or the numerical constants are allowed. An example of such a condition
would be rsl == 0. See the branch instructions in the Help->Instruction list for more
examples.

The load/store instruction syntax is different depending, whether it is a store instruction
or a load instruction. The load instruction syntax is "load dataType: (signed|unsigned)
what where offset", where load literal specifies the load instruction, dataType specifies how
many bytes are loaded from the memory (allowed values: byte, half, word, doubleword
for the integer values, float, double for floating-point values). The signed or unsigned
literals tells the interpreter, whether the loaded value should be signed or unsigned. The
what, where and offset can be either the register, the immediate value, or the numerical
constant, where what is the value to be saved, where points to the certain place in the
memory, and offset specifies the offset from the where value. The store instruction has
similar syntax being "store dataType what where offset", where the store literal specifies
the store instruction and other arguments has the same rules as in the load syntax.

Use cases
I want to run a simulation
1. Run the application
2. Move to the Code window using the tabs in the top right corner
3. Either write a new code or load the existing one
4. Press the Compile button (cog icon in the menu)
5. Confirm the pop-up dialogue

6. Use the buttons in the simulation window menu to control the simulation

I want to open the existing code

Expecting you are already running the application.
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Move to the Code window using the tabs in top right corner
Click the open icon (the folder icon in the menu) or press CTRL+S combination
Select the file, which you want to load

Confirm the dialogue

I want to save my new code

Expecting you are already running the application.

1.

2.

Move to the Code window using the tabs in the top right corner

Click the save button (the floppy disk icon in the menu) or press CTRL+S combi-
nation

. Enter the name of the file
. Specify the path, where to store your source code

. Confirm the dialogue

I want to save my existing code

Expecting you are already running the application.

1.

2.

Move to the Code window using the tabs in top right corner

Click the save button (the floppy disk icon in the menu) or press CTRL+S combi-
nation

I want to simulate at certain period

Expecting you are already running the application and code has been compiled.

1.

2.

Move to the Simulation window using the tabs in the top right corner

In the simulation menu, specify your period in the Period text field (supported units:
S, ms)

. Press the play button (the play icon in the simulation menu)

. If simulation needs to be stopped, press either the play button or stop button (the

pause icon)

I want to see each step of the simulation

Expecting you are already running the application and code has been compiled.

1.

2.

Move to the Simulation window using the tabs in the top right corner

Use the Previous and the Next step buttons to carefully observe the state in each step
(the fourth and the fifth buttons in the Simulation window)
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I want to see the result state of my source code

Expecting you are already running the application and the code has been compiled.

1
2

. Move to the Simulation window using the tabs in the top right corner

. Use the Fast-forward button to see the end state of the simulation (the sixth button
in the Simulation window)

I want to edit the buffer sizes

Expecting you are already running the application.

1

[\)

ot

. Navigate to the very top menu

. Go to Simulation->Configuration

. In the configuration select the Buffers tab
. Specify the desired sizes

. Click the confirm button at the bottom of the configuration window

I want to edit the branch configurations

Expecting you are already running the application.

1.

= w

® N> T

Navigate to the very top menu

Go to Simulation->Configuration

In the configuration select the Branching tab
Set the desired BTB size

Change the GHR and the PHT sizes

Change the predictor type in the selector
Change the initial state of all predictors

Click the confirm button at the bottom of the configuration window

I want to edit the commit or the fetch size

Exp

1.
2.

= w

ecting you are already running the application.
Navigate to the very top menu

Go to Simulation->Configuration

In the configuration select the Fetch and Commit tab

Change the fetch size and the number of ways text field

5. Change the commit size in the text field

. Click the confirm button at the bottom of the configuration window
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I want to add new function unit

Expecting you are already running the application.

1.

10.

Navigate to the very top menu

. Go to Simulation->Configuration
. In the configuration select the Function unit tab

. Select the function unit list from the sub-tabs to which you want to add the new

function unit

. Press the Add button in the Function unit sub-tab

. Set the Function unit name

If configuring ALU or FP units, write down allowed instruction split by the coma

. Specify the delay of the unit

. Create the unit by clicking Confirm button

To confirm your changes into the simulation, press Confirm button in the configuration
dialog

I want to edit existing function unit

Expecting you are already running the application.

1.

Navigate to the very top menu

. Go to Simulation->Configuration
. In the configuration select the Function unit tab

. Select the function unit list from the sub-tabs in which you want to edit the function

unit

. Select the function unit from the table that you want to edit

. Press the Edit button in the Function unit sub-tab

Edit the values in the forms

. Press the Confirm button

. When done editing, pres the confirm button in the configuration window
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I want to delete function unit

Expecting you are already running the application.

1.

Navigate to the very top menu

. Go to Simulation->Configuration

In the configuration select the Function unit tab

. Select the function unit list from the sub-tabs in which you want to delete the function

unit

. Select the function unit from the table that you want to delete

. Press the Delete button in the Function unit sub-tab

When done deleting the function units, pres the confirm button in the configuration
window

I want to change cache configuration

Expecting you are already running the application.

1.

Navigate to the very top menu

. Go to Simulation->Configuration

. In the configuration select the Cache tab

Change configuration which you wish to change - must follow constraints written in
the description

Press confirm button

I want to display contents of memory

Expecting you are already running the application.

1.
2.

3.

Navigate to the right of the screen to window selection tabs
Go to cache

On the right of the screen is contents of memory, In the middle-bottom there is
contents of cache

I want to display whole content of memory with cache data inside the
memory

Expecting you are already running the application.

1.

2.

Navigate to the very top menu

Go to Simulation->Configuration
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. In the configuration select the Cache tab

. Navigate to Cache store behaviour

. Select write through

. Run your program

. Navigate to the right of the screen to window selection tabs
. Go to cache

. On the right of the screen is contents of memory, In the middle-bottom there is
contents of cache
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